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About this document
Document organization

This User Guide consists of chapters to help introduce you to SMP Edition, the installation and configuration
requirements, how to install and configure SMP, troubleshooting items, followed by HP contact information,
a glossary, and index.

New and changed information in this edition
For information on what's new or has changed in this document since its previous release, see the SMP
Release Notes.

Related documents
For more information about HP Insight Server Migration software for ProLiant, see:

• SMP Edition product website at http://www.hp.com/go/migrate

• HP Insight Server Migration software for ProLiant Release Notes

• HP Insight Server Migration software for ProLiant Support Matrix

• Performing physical to ProLiant application migrations with the HP Insight Server Migration software
for ProLiant – Physical to ProLiant Editions white paper (contact your HP account manager)

• Portable Images Network Tool (PINT) readme files

For more information about HP Systems Insight Manager, see:

• http://www.hp.com/go/hpsim

• HP SIM Technical Reference Guide

• HP Systems Insight Manager Help Guide

Document organization 11
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1 Introduction
HP Insight Server Migration software for ProLiant

HP Insight Server Migration software for ProLiant (SMP) simplifies the server consolidation process. SMP
migrations involve moving an operating system, applications, and data from one server to another, instead
of manually redeploying these elements on a new server. SMP allows you to migrate Windows and Linux
operating systems to new compatible hardware.
SMP provides the following capabilities for Windows migrations:

• Physical-to-ProLiant (P2P) migration—Migrates a physical machine to a ProLiant server.

• Physical-to-virtual (P2V) migration—Migrates a physical machine to a virtual machine guest in a virtual
machine host.

• Virtual-to-ProLiant (V2P) migration—Migrates a virtual machine guest in a virtual machine host to a
ProLiant server.

• Virtual-to-virtual (V2V) migration—Migrates a virtual machine guest between virtualization layers.
SMP provides the following capability for Linux migrations:

▲ Physical-to-ProLiant (P2P) migration—Migrates a physical machine to a ProLiant server.

SMP benefits
• Accurate migrations—SMP removes old drivers and replaces them with new drivers on the destination

server. The source server can return to its original pre-migration state. SMP transfers operating system,
applications, and data.

• Automated migrations—SMP uses a wizard-driven process that eliminates the need for manual steps
to perform a migration.

• Less time required to perform migrations—The SMP design enables you to learn and use the tool quickly.

SMP platform support
For a list of supported platforms for SMP, see the HP Insight Server Migration software for ProLiant Support
Matrix.

SMP components
An SMP migration requires the following components:

• Application station—The computer from which the migration is set up and performed. SMP can be
installed on an HP Systems Insight Manager (HP SIM) station or as a stand-alone application. For more
information about requirements and HP SIM, see the HP SIM Technical Reference Guide.

• Source server—The physical source server or the virtual machine to be migrated.

• Destination server—The physical server or the virtual machine to which the source server is migrated.

Planning a migration strategy
One challenge when migrating operating systems, applications, and data is modifying the migrated operating
system to boot on the destination server and to function properly on the hardware. SMP is adept at making
the required operating system changes.
To best prepare for an SMP migration, consider developing a migration strategy before running a migration.
Migration strategies vary depending on machine hardware, network landscape, and applications. To develop
a migration strategy, review the following before beginning your migration.

Upgrading to SMP from SMP or P2P
You can upgrade a previous version of SMP 2.x or SMP—P2P 1.x to SMP. SMP detects older versions upon
install.

HP Insight Server Migration software for ProLiant 13



If you are upgrading from a previous version of SMP—P2P 1.x, then all remaining licenses within
SMP—P2P 1.x are detected, upgraded, and included in the SMP application. This includes Flexible Quantity,
Demo, and Subscription licenses. The licenses retain their product name in SMP; however, they are still
available for any P2P or V2P migrations.
If you are upgrading from a previous version of SMP 2.x, then only remaining Flexible Quantity (usage-based)
licenses can be detected, upgraded, and included in the SMP application. Demo or Subscription licenses
are not upgraded to the SMP application. The licenses retain their original product name; however, they
are still available for any P2V or V2V migrations.
If you are installing SMP on a separate system from the previous SMP 2.x or SMP—P2P 1.x application
station, then the remaining Flexible Quantity licenses (usage-based) can be exported and added to the SMP
application. Export and import tools for these licenses are included with SMP. For more information on these
tools, see the Licensing SMP chapter in this guide.

Downgrading to SMP or P2P from SMP
If you need to downgrade, manually uninstall SMP before downgrading to SMP or SMP—P2P or SMP.
After an SMP application is installed over the previous version of SMP 2.x or SMP—P2P 1.x, do not reinstall
the previous version of SMP or SMP—P2P. Licenses that were migrated from the previous version of SMP or
SMP—P2P are upgraded to SMP and cannot be downgraded back to SMP or SMP—P2P.

Hardware and operating system support
Before beginning a migration, verify that the source server operating system is supported on the destination
server or host by HP and that the operating system is supported for the migration type selected.
Because the SMP wizard does not block migrations of unsupported operating systems, you must verify that
the selected operating system is supported before beginning the migration. To verify if the operating system
is supported on ProLiant destination servers, see http://www.hp.com/go/ossupport.

CAUTION: Attempting to migrate an unsupported operating system configuration might result in a failed
migration and unnecessarily consuming a license.

Supported destination ProLiant servers with unsupported embedded controllers are not supported by SMP
for P2P and V2P migrations.
Before starting a P2P or V2P migration, review the HP Insight Server Migration software for ProLiant Support
Matrix, and verify that the embedded storage controller and network interface card (NIC) options appear
on the supported controller list of the support matrix for the destination ProLiant server. Remove unsupported
storage and NIC controllers before performing a migration. Unsupported storage and NIC controllers can
be added back to the destination server, with proper manual configuration, after performing a migration.

Configuration planning
When performing a P2P or V2P migration, prepare your destination server disk sizes and configuration to
accommodate the partitions to be migrated. You can change the logical disk numbers on the destination
server. For example, data on \PhysicalDrive5 on the source server during a Windows migration might
be reordered to \PhysicalDrive2 on the destination server. During a Linux migration, data on /dev/sda
on the source server might be reordered to /dev/sdc on the destination server.
When performing a P2V or V2V migration, be sure your destination virtual machine host has adequate
memory, processor resources, and disk space to migrate the source server partitions. For example, if disk 1
on your source server has 10 GB of data to migrate, verify that the disk you migrate to on the destination
server has at least 10 GB of available disk space.

License verification
Before performing a migration, review all hardware, operating system, and application licenses on the
source server and acquire all valid licenses necessary for the destination server. Some hardware, software,
and operating systems license agreements might require you to purchase a new license for the destination
server.

14 Introduction
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IMPORTANT: Servers with Windows Original Equipment Manufacturer (OEM) licenses are not supported
for migration. For licensing questions, contact HP support.

Schedule preparation
Schedule preparation is essential when planning a migration strategy.
Be sure to include adequate time for copying data. Large volumes take time to migrate. Under optimal
conditions, an SMP migration requires two to three minutes to migrate 1 GB of data. Using two minutes as
a best-case scenario, migrating 500 GB of data might take more than 17 hours.
When a migration starts, the source server reboots to a minimal configuration so that no updates occur on
the source server during migration. Only those services required for the migration are enabled.
Applications that normally execute on the server are not available during migration. After the migration is
complete, the source server is restored to its pre-migration state.
Schedule the migration to occur at a time when the source server can be offline.

Memory and CPU resources on the application station
Insufficient memory and CPU resources on the application station might degrade performance and cause
errors during migration. For best results, close all other applications on the application station before the
migration. Open the applications after the migration is complete.

Critical or hardware-dependent application preparation
Some hardware applications are bound to the source server and might need reconfiguration to function as
expected following an SMP migration.
For added safety, manually disable critical and hardware-dependent applications before migrating a source
server. You can then manually re-enable these applications after the migration is complete.
Manually disabling applications prevents them from starting on the destination server before they are
reconfigured for the destination server.
Examples of applications that must be disabled during migration include:

• Applications that rely on unique hardware serial numbers, BIOS or chassis IDs, NICs, MAC addresses,
or devices that authenticate a piece of software.

• Applications that store data on a volume different from that of the operating system. SMP retains drive
letters (for example, F:) during migration, but hardware differences between the source and destination
servers can force the drive letters to change.

• Applications that depend on physical disk identifiers instead of drive letters. Depending on the destination
server disk enumeration order and selections made in the SMP Migration Wizard, the contents of a
physical disk might have a different sequential identifier on the destination server. In these cases, the
application must be reconfigured to use the new physical disk identifiers.

Virtual machine guest tools
Before starting a migration, you must uninstall the guest tools if you are migrating a source virtual machine.
The guest tools are not applicable on the destination server and might cause issues with the normal functioning
of the network adapters, keyboard, and mouse. After the migration is completed, you can reinstall the Guest
tools on the source virtual machine.

Domain controllers
SMP supports migration of domain controllers.
To migrate a domain controller on a source server:
1. Reboot the server.
2. During reboot, press F8 to boot to Directory Services Restore Mode (DSRM).
3. Launch the SMP Agent in DSRM mode.
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The migration runs in Directory Services Restore Mode instead of booting into SMP Agent Mode. As a result,
CHKDSK does not run before the migration of domain controllers.
For more information about preparing a migration of domain controllers, see your HP account manager for
the white paper Performing physical to ProLiant application migrations with the HP Insight Server Migration
software for ProLiant – Physical to ProLiant Edition.

Microsoft Small Business Server
SMP only supports migrations of Microsoft® Small Business Server operating systems for P2P. Small Business
Server operating systems include a domain controller on the server. Follow the steps required to migrate a
domain controller to ensure successful migration of Small Business Server.

Firewalls
The Microsoft Windows® firewall is disabled on a source server when a migration begins. The firewall is
re-enabled after the migration is completed.
Before performing the migration, you might need to manually disable, reconfigure, or uninstall other firewall
products. If you reconfigure a firewall product, you might be required to uninstall the product before migration
and reinstall it after migration.
If the firewall is not disabled or reconfigured properly on the source server, application station, and virtual
machine hosts before performing a migration, then the source server, application station, and virtual machine
hosts might not be able to effectively communicate. Resulting symptoms of this issue can include the following:

• The application station cannot detect the source server SMP Agent for migrations

• The source server hangs after booting in SMP Agent Mode during migrations

• The application station cannot detect the virtual machine host SMP Agent for migrations

The following ports are used for SMP migrations using TCP:

• Port 51124—For communication between the SMP Web Service and the SMP application service using
Secure Sockets Layer (SSL)

• Port 51125—For communication between the SMP Web Service and integrated Lights Out (iLO) for
auto destination boot

• Ports 51125 and 51126—For communication between the SMP application service and the SMP Agent
on the source server or source virtual machine host using SSL

• Ports 51125 and 51126—For communication between the SMP application service and the SMP Agent
on the destination server or destination virtual machine host using SSL

• Port 51126—For communication between the SMP Agents on the source server or source virtual machine
host and destination server or destination virtual machine host using SSL

• Port 51127—For use on the application station for SMP Web Server

When the SMP VM Host Agent is installed, the ports previously listed automatically open up in the ESX and
Windows firewalls.
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NOTE: SMP uses the following encryption types:

SSL RSA with RC4 128 MD5•

• SSL RSA with RC4 128 SHA

• TLS RSA with AES 128 CBC SHA cipher suites

Antivirus software
For optimal performance during migration, verify that no antivirus scans are running or are scheduled to run
while the migration is performed on the application station, source server, or virtual machine hosts.

Dual-boot
In a dual-boot scenario, where one or more operating systems on the boot disk of the source server are not
supported but the operating systems exist on a supported file system, keep in mind the following:

• A supported operating system must be set as the default operating system for the boot disk.

• The Migration Wizard enables the migration of all partitions with supported file systems. Unsupported
operating systems on those partitions are also enabled for migration, but SMP does not support them.

• If unsupported operating systems are migrated, they might be detected, but proper drivers might not
be installed, which can leave the unsupported operating system on the destination server unbootable.

Resizing NTFS volumes for Windows migration
Under some conditions, SMP cannot resize New Technology File System (NTFS) partitions. Examples include
the following:

• Large NTFS partitions, usually larger than 1 TB, or NTFS partitions with too many clusters, resulting in
large volume cluster bitmaps that cannot be resized. In some cases, the volume might be recognized
as RAW (partitions in which no file systems exist). Although SMP can perform migrations on these
volumes, SMP cannot resize them.

• Volumes with bad clusters. If an NTFS volume is detected but cannot be resized, you must run a disk
check (for example CHKDSK.exe) to verify the volume has no bad clusters before beginning the migration
process. The migration of volumes with bad clusters is not supported by SMP and requires that you
manually migrate volumes with bad clusters to the destination server after a migration.

• Resizing disks for agent-based P2V or V2V migrations cannot be performed using a Windows 2008
application station. The partitions can be resized only if they are migrated using a Windows 2003
application station.
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File system selection for a Linux source server
Bad blocks on Linux file systems are not supported by SMP. To ensure that the source file system does not
have bad blocks, run file system-specific tools.
Resize is not supported for Linux file systems.

ProLiant Support Pack

IMPORTANT: The information in this section applies only to P2P or V2P migrations.

SMP does not install all drivers (including NIC drivers) on the destination server. To acquire the latest drivers,
you must install the HP ProLiant Support Pack (PSP) following migration on the destination server.
You can configure SMP to automatically install PSP after the Windows migration is completed. To use this
feature, you must upload the Windows PSP executable from the Upload Drivers tab on the SMP Migration
Wizard.
For more information for required post-migration configurations, for P2P migrations see the P2P post-migration
tasks section, and for P2V migrations see the P2V post-migration tasks section.

Linux Support Pack

IMPORTANT: The information in this section applies only to P2P migrations.

SMP does not install all drivers (including NIC drivers) on the destination server. To acquire the latest drivers,
you must manually install the HP Linux Support Pack (LSP) following migration on the destination server.

Related HP products
SMP enables migration-related tasks to be performed. The following table lists HP products that are available
for extending deployment or customizing the migrated server.
Table 1-1 Related HP products for extending deployment

DescriptionProduct

Automates the management of software such as operating systems, applications, patches, content,
and configuration settings, so that each computing device is maintained in the right configuration.

HP OpenView Change and
Configuration Management
solutions

A server deployment solution that facilitates the installation, configuration, and deployment of large
server volumes through a GUI-based or a web based console, using scripting or imaging technology.
Server configuration time is reduced, making it possible to quickly scale server deployments to large
volumes.

HP ProLiant Essentials Rapid
Deployment Pack

Provides step-by-step ProLiant server deployment assistance. From configuring arrays and installing
operating systems, to updating optimized ProLiant server support software, SmartStart ensures a
stable and reliable configuration. Included in the ProLiant Essentials Foundation Pack, the SmartStart
CD works with all ProLiant DL and ML 300, 500, and 700 series, and all ProLiant BL servers.

HP SmartStart CD

A server deployment product that delivers unattended automated installation for high-volume ProLiant
server installations.
Available in Win32 and Linux editions, the toolkit supports ProLiant DL and ML 300, 500, and 700
series, and all ProLiant BL servers.
The toolkit includes a modular set of utilities and important documentation that describes how to
apply these tools to automate server deployment.

HP SmartStart Scripting Toolkit
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2 SMP installation and configuration requirements
This chapter lists the hardware and software required for each component in the SMP environment. The SMP
environment consists of the following components:

• Microsoft Windows-based application station

• Physical or virtual source server

• Physical or virtual destination server

• Destination virtual machine host (for P2V and V2V only)

HP SMP application station and HP SIM Central Management Server (CMS)
The application station requires the following components to be installed:

• A 32-bit version of supported Windows operating systems. For a list of operating systems, see the HP
Insight Server Migration software for ProLiant Support Matrix.

NOTE: The application station can also be installed on a virtual machine running a supported Windows
operating system. The virtual machine can run in one of the following hypervisors:

• Integrity VM HP-UX running as guest on an HP-UX 11i v2 operating system

• Integrity VM HP-UX running as guest on an HP-UX 11i v3 operating system

• Microsoft Hyper-V

• VMware ESX 3.0.1 running as guest on a 32-bit Windows operating system

• VMware ESX 3.0.2 running as guest on a 32-bit Windows operating system

• VMware ESX 3.0.3 running as guest on a 32-bit Windows operating system

• VMware ESX 3.5 Update 1 or later

• VMware ESX 3.5 Update 3 or later running as guest on a 32-bit Windows operating system

• VMware ESX 3i Update 2 running as guest on a 32-bit Windows operating system

• VMware ESX 3i Update 3 running as guest on a 32-bit Windows operating system

• Microsoft iSCSI Initiator 2.06, 2.07, or 2.08, which you can download and install from
http://www.microsoft.com–Other versions of the initiator, including later versions, cannot be used with
this version of SMP.

• If you are using Windows 2008 on the CMS, the iSCSI Initiator v 6.0 must be installed and started.

• Microsoft Internet Explorer 6.0 or 7.0, Mozilla Firefox 2.0.0.16 or Mozilla Firefox 3.0.0

• SMP installed on an NTFS partition

• Available memory of at least 600 MB

• Screen resolution of at least 1024x768

• Available disk space of at least 900 MB

• Availability of ports 51124 and 51125 (or ports specified during SMP installation for agent
communications and iLO booting)

• Availability of port 51127

• User account credentials with administrative rights

• Free disk space of at least 300 MB per iLO Boot while booting a destination server for P2P and V2P

SMP does not require the application station to be running HP SIM, but it is supported. SMP is compatible
with HP SIM 5.3.
SMP does not require the application station to be running HP Virtual Machine Management Pack (VMM),
but it is supported. SMP is compatible with Virtual Machine Management Pack version 3.6.
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SMP application station does not support an automatic downgrade to SMP version 3.6. If downgrading,
uninstall SMP before installing an older version.
Before upgrading the application station, moving the application station to a different server, or preserving
the SMP configurations for future installations, back up the following files:

• SMP installation folder\log

• SMP installation folder\bin\iLOIP.lst

• SMP installation folder\bin\hpvmm.conf

Windows source servers
The physical or virtual Windows source server requires the following components to be installed:

• User account credentials with administrative rights

• A 32-bit version of supported Windows operating systems. For a list of operating systems, see the HP
Insight Server Migration software for ProLiant Support Matrix.

• Available disk space of at least 180 MB

• The availability of ports 51125 and 51126

• Screen resolution of at least 800x600

NOTE: If the source server is an SMP application station, the SMP application service and SMP Web
Service must be stopped before agents are installed.

Linux source servers
The physical Linux source server requires the following components to be installed and running:

• User account credentials with administrative rights

• SELinux must be running in passive mode

• A 32-bit version of supported Linux operating systems. For a list of operating systems, see the HP Insight
Server Migration software for ProLiant Support Matrix.

• Available disk space of at least 110 MB

• The availability of ports 51125 and 51126

Physical destination servers
A supported ProLiant destination server must be used for P2P or V2P migrations. For a list of supported
ProLiant servers for P2P and V2P, see the HP Insight Server Migration software for ProLiant Support Matrix.
The destination server disks must be configured to support migration of source servers.

Virtual machine hosts
The destination virtual machine hosts require the following components to be installed:

• A supported virtual machine host, used for destination with SMP for P2V or V2V migrations. For a list
of supported virtual machine hosts for P2V and V2V migrations, see the HP Insight Server Migration
software for ProLiant Support Matrix.

• User account credentials with administrative rights

• Available memory of at least 600 MB

• Available disk space of at least 256 MB for agent-based hosts and 750 MB for agent-less hosts

• The availability of ports 51125, 51126, and 51127 for agent-based migrations

• The latest updates installed
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Installing SMP on the application station
To install SMP, you must have administrative rights. However, any user can access the application after SMP
is installed.
SMP must be installed on the application station to perform an SMP migration.
Use the following procedure to install SMP on an application station or on an HP SIM server.
1. Insert the SMP Boot CD in the CD drive of the selected application station.

The CD autorun utility displays the installation screen.

2. Click Install Application. The Welcome screen appears.
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3. Click Next.
4. The License Agreement screen appears. Read the license agreement, select I accept the agreement,

and then click Next.

5. Select the destination location for the SMP application. The default location is
C:\Program Files\HP\HP Insight Server Migration software for ProLiant. Click
Next.
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6. Enter the service credentials, and port changes if necessary, and then click Next.

NOTE: To install SMP, you must have administrative rights. However, any user can access the
application after SMP is installed.

7. Click Finish.
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Changing the default SMP application station service port number
By default, SMP uses 51124 as the default port for communications.
Use one of the following methods to change the port:

• Change the port number during SMP installation.

• Manually change the port number after SMP installation.
Edit the<SMP Installation Directory>\bin\hpvmm.conf file by adding the following
line and saving the file:
hpvmmsvcport=new SMP service port number on application station

1.

2. Restart the HP SMP Edition application service and the HP SMP Edition Web Service.

Accessing the product documentation on the SMP Boot CD
To access the product documentation, click the Documentation tab.
Product documentation available on this tab includes this guide and the HP Insight Server Migration software
for ProLiant Support Matrix.
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3 Deploying SMP Agents
Deploying SMP Source Agents

Before starting a migration, SMP Agent must be running on the source and destination servers. Therefore,
verify the proper agent is applied to the source and destination server.
To launch SMP Agent, you must have administrative rights to connect to the source server.
Before performing a migration, remove CDs, floppy disks, USB keys, or other detachable media from the
source server.
You can deploy SMP Agent using one of the following methods:

• Using the Central Management Server (CMS) with HP SIM installed

• Using the application station with stand-alone SMP installed

• Using executables located on the SMP application station

• Using Install SMP Source Agent on autorun of the HP SMP 3.70 CD (Windows migrations only)

NOTE: Source agents cannot be deployed to Windows 2008 servers using the Deploy Agent tab on the
application station wizard. You must either manually copy the hpsmpagent.exe from the <installation
dir>\Agents\SMP folder to the source server or connect the SMP installation CD to the source server, and
then install the SMP Source Agent by clicking Install SMP Source Agent in the auto run window of the
SMP application.

SMP Agents
The following SMP Agents are available:

• Windows VM Host Agent—This agent must be launched on a target virtual machine host running on a
Windows operating system that is used for P2V or V2V migrations. This agent must be applied when
a destination virtual machine is created on an agent-based virtual machine host running a Windows
operating system. This agent runs as a service on the virtual machine host and does not need to be
reapplied for multiple migrations. However, if a migration is started to a virtual machine on this virtual
machine host, then other simultaneous migrations to any other virtual machine on the same virtual
machine host are queued. To determine whether your virtual machine host is agent-based, see the HP
Insight Server Migration software for ProLiant Support Matrix or see the “Agent-based hypervisors”
section.

• Linux VM Host Agent—This agent must be launched on a target virtual machine host running on a Linux
operating system that is used for P2V or V2V migrations. This agent must be applied when a destination
virtual machine is created on an agent-based virtual machine host running a Linux operating system.
This agent runs as a service on the virtual machine host and does not need to be reapplied for multiple
migrations. However, if a migration is started to a virtual machine on this virtual machine host, then
other simultaneous migrations to any other virtual machine on the same virtual machine host are queued.
To determine whether your virtual machine host is agent-based, see the HP Insight Server Migration
software for ProLiant Support Matrix or see the “Operating system” section.

• SMP Windows Source Agent—This agent must be launched on the Windows source server or virtual
machine before performing a migration. This agent does not run as a service on the source server and
must be applied for each migration.

• SMP Linux Source Agent—This agent must be launched on the Linux source server or virtual machine
before performing a migration. This agent does not run as a service on the source server and must be
applied for each migration.
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SMP supported Windows migrations

Agent-less hypervisors

• HP integrated VMware ESXi 3.5

• HP integrated VMware ESXi Update 1

• HP integrated VMware ESXi Update 2

• HP integrated VMware ESXi Update 3

• HP integrated VMware ESXi Update 4

• Citrix XenServer 5.0

• HP integrated Citrix XenServer

• Microsoft Hyper-V™

• Microsoft Hyper-V Server 2008

• VMware ESX 3.5

• VMware ESX 3.5 Update 1

• VMware ESX 3.5 Update 2

• VMware ESX 3.5 Update 3

• VMware ESX 3.5 Update 4

Agent-based hypervisors

NOTE: Windows 2008 virtual machine migrations are not supported to or from Microsoft Virtual Server.

• Microsoft Virtual Server 2005 R2

• Microsoft Virtual Server 2005 R2, Service Pack 1

• VMware™ Server 1.0.5 (installed on a Windows system only)

• VMware Server 1.0.6 (installed on a Windows system only)

• VMware Server 1.0.7 (installed on a Windows system only)

• VMware Server 1.0.8 (installed on a Windows system only)

• VMware ESX 2.5.5

• VMware ESX 3.0

• VMware ESX 3.0.2

• VMware ESX 3.0.2 U1

SMP supported Linux migrations

Operating system
Red Hat Linux 5.2 32-bit

Linux operating system requirements

NOTE: For Linux migrations, GRUB Boot Loader is required as the primary boot loader on the source.

SMP supports the following file systems without disk resizing:

• ext2/3

• reiserfs

• Linux Swap
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The following are not supported with Linux migrations:

• Migrations with hypervisor

• Migrations installed with Windows in dual-boot mode

• Migrations to SAN disk

• Migrations with para-virtualized or non-standard kernels

• Migrations of LVM snapshots

• Migrations of Linux OS with encrypted partitions (Software RAID is not supported)

• Running any post-migration steps such as Linux Support Packs installation and HP SIM discovery

SMP Boot CDs
• SMP Physical Boot CD—This is the default SMP CD. You can use this CD to install SMP application or

SMP Source Agent, or to boot physical destination server for X2P migrations.

• SMP Virtual Boot CD—This CD is used to boot the destination virtual machine for migrations to agent-less
virtual machine hosts. This CD ISO is available after SMP is installed.
To access the ISO, see <SMP directory>\webserver\webapps\smpui.

Table 3-1 Server and agent type

Agent typeServer

Windows SMP Source AgentPhysical Windows source server

Linux SMP Source AgentPhysical Linux source server

Windows SMP Source AgentVirtual machine source

SMP Boot CDPhysical destination server

Windows SMP VM Host AgentVirtual machine destination on host with agent-based console
operating system running Windows

Linux SMP VM Host AgentVirtual machine destination on host with an agent-based console
operating system running Linux

SMP Virtual Boot CDVirtual machine destination on agent-less host

Using the HP SIM CMS to deploy SMP Agent
You can deploy SMP Agent through the HP SIM CMS menu or through the HP SIM 5.3 Quick Launch feature.

Deploying SMP Agent through the HP SIM CMS menu if SMP and HP SIM 5.3 are installed
1. From the HP SIM toolbar, select Deploy→Drivers, Firmware and Agents.
2. Select Install SMP Agent, and then select the server to deploy to the agent.

The Deploy Agent tab appears when SMP is launched.

3. From the Deploy Agent tab, select the agent type, and then enter the credentials.
4. From the Deploy Agent tab, view servers discovered in HP SIM by clicking Show Host List.

The Show Host List displays the following:

• If you select to deploy to a Windows host, Windows servers discovered
in HP SIM.

• If you select to deploy to a Linux (ESX) host, Linux servers discovered
in HP SIM.
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Deploying SMP Agent through the HP SIM CMS Quick Launch feature

NOTE: If you are migrating a server with an older version of the SMP Application Station software installed,
stop the SMP services before installing the SMP Source Agent.

1. Select a source server to launch SMP Agent in HP SIM.
2. Scroll over the Quick Launch feature, and then select Install SMP Agent.

The Deploy Agent tab appears in the SMP application.

Using the application station to deploy SMP Agent
Use these deployment methods for stand-alone systems that deploy SMP Agent through an application station
without HP SIM CMS. SMP Agent can be installed from the Deploy Agent tab of the wizard or from the
Migration Wizard during migration setup for source servers.

Deploying SMP Agent using the Deploy Agent tab of the wizard on the application station
1. Open SMP, and then click the Deploy Agent tab.
2. Review the SMP Agent table. Select the proper agent for deployment, or scroll down below the table,

and then select one of the following:

• Install VM Host SMP Agent—Select this option to specify the operating system on the virtual machine
host, and then select Windows or Linux for the virtual machine host.

• Install SMP Source Agent—Select this option for Windows SMP Source Agent deployment on a
Windows source server or Linux SMP Source Agent deployment on a Linux source server.

3. In the IP Address, User Name, and Password boxes, enter the credentials, and then click Install
Agent. The source server cannot have a blank password.

4. View the deployment status and result of SMP Agent.
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Deploying SMP Source Agent directly from the Migration Wizard on the application station
1. Open the SMP application, and then click the Migration Wizard tab.

The Migration Wizard overview screen appears.

2. Select the relevant OS type and the migration option, and then click Next.
3. In step 1 of the Migration Wizard, enter the Server Name or IP address of the source server, and then

select Deploy SMP Source Agent.
4. Enter the user name and password for the source server, and then click Next. You can specify a domain

account in the domain\username format in the user name field. In addition, the Password field
cannot be blank.
To check the progress of the agent launch, select the View Status/Logs tab.

Manually running SMP Source Agent on the source server

Deploying Windows SMP Source Agent locally on the source server
1. Access SMP Source Agent in the following folder on the application station:

<SMP Installation Folder>\Agents\SMP\hpsmpagent.exe

2. Copy the file in this folder to the source server, and then run the file. If a security warning window
appears, click Run on the window.

3. To launch SMP Source Agent, click Install.
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When SMP Source Agent is ready for migration, the following screen appears on the source machine.

NOTE: The following screen appears only if X Windows was used.

4. Record the IP addresses listed for the source server entry when using SMP.
After the application station is connected to SMP Agent on these servers, the agent is locked to the
application station.
To unlock the connection between the application station and the source server, access the agent console
on the source server, and then click Abort and Exit.
To stop the source agent, on the source page, click Abort and Exit.

NOTE: After completing a migration, SMP Source Agent no longer runs on the source server.

Deploying Linux SMP Source Agent locally on the source server
1. Access SMP Source Agent in the following folder on the application station:

<SMP Installation Folder>\Agents\SMP\hpsmpagent.tar.gz
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2. Copy the file in this folder to the source server, and then extract the file.
3. To launch SMP Source Agent, go to the bin folder of the extracted directory, and then execute the

script startHPSMPCnt.sh.
When SMP Source Agent is ready for migration, the following screen appears on the source machine.
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NOTE: The following screen appears only if X Windows was used.

4. Record the IP addresses listed for the source server entry when using SMP.
After the application station is connected to SMP Agent on these servers, the agent is locked to the
application station.
To unlock the connection between the application station and the source server, access the agent console
on the source server, and then click Abort and Exit.
To stop the source agent, on the source page, click Abort and Exit.

CAUTION: If you use RHEL, the firewall and SELinux are automatically stopped by the agent deployment.

NOTE: After completing a migration, SMP Source Agent no longer runs on the source server.

Installing SMP Source Agent on a Windows 2008 Server
Source agents cannot be deployed to Windows 2008 servers using the Deploy Agent tab on the application
station wizard.
Perform one of the following steps:

• Manually copy the hpsmpagent.exe file from the <installation dir>\Agents\SMP folder to
the source server.

• Connect the SMP installation CD to the source server, and then install the SMP Source Agent by clicking
Install SMP Source Agent in the auto run window of the SMP application.
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Restarting the SMP Agent
Table 3-2 Restarting SMP Agents on source and destination servers

WindowsAgent type

On the agent console, click Abort and Exit, and then redeploy the agent.SMP Source Agent

Restart the HP Server Migration Pack VM Host Agent service.SMP VM Host Agent

Restart the server and boot using the SMP Boot CD.SMP Agent running as part of Boot
CD

Booting the destination server for P2P, V2P, and X2V (agent-less) migrations
If you are performing a P2P or V2P migration, you must boot the destination server using the applicable
SMP Boot CD. For X2V (agent-less) migrations, use the SMP VM Boot CD. To boot the destination server for
physical servers, you must be able to reboot the server and load a CD, either manually or through iLO. For
virtual servers, you must have access to the virtual machine host management console.
The SMP Boot CD can only boot supported destination servers with supported primary storage controllers.
For a list of supported servers and storage controllers, see the HP Insight Server Migration software for
ProLiant Support Matrix.
To manually or automatically boot the destination server or virtual machine to proper SMP Boot CD, see the
following procedures. After the destination system is booted, you must configure it to launch the destination
agent.

Manually booting a physical destination server using the SMP Boot CD for P2P and
V2P

1. Perform one of the following steps:

• Insert the SMP Boot CD in the destination server, and then reboot the server.

• Boot the server remotely using the iLO virtual media feature.

2. Follow the steps in the Configure Boot CD to launch destination agent section in this guide.

Booting a destination server using the SMP Migration Wizard
1. In step 3 of the P2P or V2P Migration Wizard, select Boot destination server automatically.
2. Enter the iLO IP address and iLO credentials.
3. Click Boot Destination Server.
4. To view progress of the boot to SMP Boot CD, click Launch iLO, and then log in to the iLO Remote

Console.
The following requirements must be met to use the boot from iLO feature:

• The iLO user credentials provided must have "Virtual Power and Reset" and "Virtual Media" access
applied.

• The browser must be configured to support HTTP 1.1. To add this support:
On your web browser, open Internet Options, and then select the Advanced tab.1.

2. As appropriate, select Use HTTP 1.1 and Use HTTP 1.1 through proxy connections.

• To access the remote console, the iLO Advanced License must be applied.

• At least 300 MB of free space for each iLO Booting is required on the application station on the disk
where SMP is installed. This space is recovered once the migration is completed or the boot job times
out.

After the destination server is booted to the SMP Boot CD, to launch the SMP Agent on the destination server,
see the Configure Boot CD to launch destination agent section in this guide.
If the migration is not performed within two hours of the server being powered up through iLO, the server
powers down. If the application service is restarted before this time, use the command line interface to resolve
issues related with virtual media. The list of IP of the server where Virtual media stays connected, can be
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found in the iLOIP.lst file. This file can be found at <install dir>\bin\. After all virtual media issues
are resolved with the help of the command line interface, this file can be deleted..
The command line interface can be accessed from the bin folder of the install directory. At the command
prompt, enter the following:
ResetILOVM.cmd -i xxx.xxx.xxx.xxx -u username -p password

Replace xxx.xxx.xxx.xxx with the iLO IP address.

Manually creating and booting a virtual machine destination server for P2V and V2V
(agent-less)

IMPORTANT: For Windows 2000 server migrations to HP integrated VMware ESXi 3.5, you must create
the virtual machine with BusLogic Storage controller.

1. Access the virtual machine host management console provided by VMware, HP integrated Citrix
XenServer, or Hyper-V.

2. Create a new virtual machine with sufficient disk space for migration.
3. Boot the virtual machine to the SMP VM Boot CD. The SMP VM Boot CD can found in the following

location on the application station:
<Installation Folder>webserver\webapps\smpui\

4. After the destination virtual machine is booted to the SMP VM Boot CD, to launch the SMP Agent on
the destination virtual machine, follow the steps in the Configure Boot CD to launch destination agent
section in this guide.

NOTE: When a virtual machine is booted on an HP integrated Citrix XenServer, the mouse might not work.
If this occurs, use the keyboard when navigating through the Boot CD user interface.

Manually creating and booting a virtual machine for SMP

Prerequisites for manually creating and booting a destination virtual machine
This section lists the prerequisites for manually creating a virtual machine for different migrations.
To manually create and boot a destination virtual machine, you must create the virtual machine with the
prerequisites specified, and then attach the SMP Virtual Boot CD to the virtual machine. The SMP Virtual
Boot CD smpbootcd-v-3.70.iso can be found in the products folder of the SMP Boot CD.

Hyper-V migration

• Ensure that the virtual machine does not have more than three disks attached.

• Ensure that the virtual machine has at least 600 MB of memory.

• Ensure that the network adapter is a legacy network adapter.

• Ensure that the network adapter is connected to a virtual network switch which is connected to an
external network.

• Ensure that the virtual disks that you create are attached to an IDE controller.

• Ensure that the boot virtual disk is connected to the 0th channel of the first IDE controller.

• Ensure that the SMP Virtual Boot CD is attached to one of the channels of an IDE controller.

VMware ESX migration

• Ensure that the virtual machine has at least 600 MB of memory.

• Ensure that the virtual machine is created by selecting the correct operating system that is being migrated.

• Ensure that the virtual machine is created with at least one Flexible Network Adapter.

• Ensure that the network adapter is connected to a virtual network switch that is connected to an external
network.
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• For Windows 2000 migrations, ensure that the storage controller selected is BusLogic.

• Ensure that the SMP Virtual Boot CD is attached to a Virtual CD-ROM device.

HP integrated Citrix XenServer migration

• Ensure that the virtual machine has at least 600 MB of memory.

• Ensure that correct operating system for the virtual machine being created is selected.

• Create the virtual machine with just one virtual network interface that is connected to the proper virtual
network.

• For HP integrated Citrix XenServer 1.0 or 1.1, do not create a virtual machine with more than three
disks attached.

• Ensure that the SMP Virtual Boot CD is attached to a Virtual CD-ROM device.

Automatically creating and booting a virtual destination server using the SMP
Migration Wizard for P2V or V2V

NOTE: This section applies only to P2V or V2V migrations to HP integrated VMware ESXi 3.5, Hyper-V,
and HP integrated Citrix XenServer.

NOTE: The destination virtual machine should be connectable on ports 51125 and 51126 from both the
application station and the source machine.

To create and boot the destination virtual machine using the Migration Wizard, perform the following steps:
1. Run the Migration Wizard, and in step 3 of the P2V and V2V Migration Wizard, select the appropriate

VMware ESXi, Hyper-V, or HP integrated Citrix XenServer virtualization layer.
2. Enter the login credentials for the virtual machine host.
3. Select Boot VM Automatically, and then enter the IP address details for the virtual machine. This

IP address is assigned to the agent running on the virtual machine and is used for the migration.
4. Click Next.
5. Enter the virtual machine configuration details in step 4 of the migration, and then click Next.

SMP application connects to the virtual machine host, creates the virtual machine, and then boots up
the virtual machine using the SMP VM Boot CD.
After the Boot CD Agent is launched on the provided IP address, the application station connects to the
agent on the Boot CD, and the next page of the wizard appears.

6. If the application is unable to connect to the destination virtual machine, return to step 3 of the Migration
Wizard, and then manually create a virtual machine. To specify the IP address of the destination virtual
machine, select Destination VM is already booted with Boot CD, and then continue with the migration.

NOTE: If you cancel VM Booting or if it fails, the SMP application station does not delete the virtual machine.
Using the VM Host Management console, you can delete the virtual machine manually.

Configure Boot CD to launch destination agent
After the destination server or virtual machine is booted to the proper Boot CD, perform the following steps:
1. Select the keyboard language to use, and then click Next.
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2. Review the system and storage configuration information to ensure the setup is correct. The system
information section includes the following information:

• RAM

• Boot controller

• Boot controller disk size

• PCI device information (collapsed by default)–only applicable for X2P migrations

If the boot controller disk size is zero or the controller is not supported, an error message appears under
PCI device information.
If a bootable drive is not configured on this system, see the Post-migration section in this guide.
If the primary controller configured in your system is not supported by this version of the SMP application,
see the HP Insight Server Migration software for ProLiant Support Matrix for a complete list of supported
controllers for the destination server (only applicable for X2P migrations).
Configure the storage on this server to accommodate the data to be migrated from the source server.
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3. (Optional) This step only applies to physical servers. To configure or reconfigure the HP array controllers,
click Launch Array Configuration Utility. The Array Configuration Utility appears in a new window.
The server reboots after exiting the Array Configuration Utility. For virtual servers, the Launch Array
Configuration Utility button does not appear.

4. To proceed with network configuration, click Next.•

• (Optional) To cancel the agent launch on the destination server and eject the SMP Boot CD, click
Abort Migration and Reboot.

5. You can only configure one IP address for the destination server. Ensure that the selected network card
can connect to the same network as the application station. Configure the network to enable the SMP
Agent by selecting the adapter from the list. Select one of the following:

• Dynamically obtain an IP address from a DHCP server—This is the default option. The list and text
boxes are disabled when DHCP (Dynamic Host Configuration Protocol) is selected.

• Configure a Static IP Address—The list displays all available network cards for this system. The
Select Adapter, IP Address (must be unique), and Subnet Mask entries are required.

Specifying the gateway information is optional. The Next button is disabled until the required entries
are entered, or if an invalid value for the IP Address, Subnet Mask, or Gateway is entered.

6. You can set the duplex settings for the selected card by selecting one of the following from the Duplex
Setting list:

CAUTION: Some duplex settings might not be supported for all NICs. However, this does not prevent
the server migration. The default is set to Auto-negotiate On mode.

• Ignore—This option is selected by default and continues with the current duplex setting for the
selected network card from the Selected adapter list.

• Auto-negotiate on—Select this option to enable auto-negotiation for the selected network card.

• 100 MB Full Duplex—Select this option to set full duplex to 100 MB. Full duplex is the capability
to send data in both directions at the same time.

• 1000 MB Full Duplex—Select this option to set full duplex to 1000 MB.
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7. To launch the SMP Agent, click Next.

8. When a message appears advising you that the destination server is ready for migration:
a. Record the IP address listed on the screen for the destination server entry when using the SMP

application.
b. Perform the migration from the application station. A message appears on the destination server

that reports the migration progress when the data copy process begins.

CAUTION: Do not exit from the ProLiant Destination Migration Status screen or remove the
SMP Boot CD. These actions terminate the migration.

c. (Optional) For P2P and V2P migrations, after completing the migration, update the device drivers
on the target machine with the PSP. For more information about post-migration steps, see the
P2P post-migration tasks and V2P post-migration tasks sections in this guide.
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If the SMP Agent fails to launch, an error message appears on the destination server. To reconfigure the
network, click Previous. If the issue persists, reboot the destination server.

NOTE: After completing a migration, the SMP Agent no longer runs on the destination server.

After the application station is connected to the SMP Agent on the destination server, the agent is locked to
the application station. To unlock the connection between the application station and the destination server,
click Abort migration and Reboot. To relaunch the SMP Agent, reboot the server using the SMP Boot CD
for X2P migrations and the SMP VM Boot CD for X2V migrations.

SMP Overview screen
After SMP installation is complete, the Overview screen appears.

SMP Overview screen 41



The SMP Overview screen has six tabs:

• Overview—This tab provides the following information or functions:

Types of server migrations supported•

• Migration steps overview

• Hyperlinks to access a PDF of the user guide and support matrix in a new window.

• Option to set the Migration Wizard page as the default page. To enable this wizard to start by
default, select Start the Migration Wizard when opening this application.

• License—This tab enables you to view the number and types of SMP licenses available and to add new
SMP license keys. For more information about licensing, see the Licensing SMP chapter in this guide.

• Migration Wizard—This tab enables you to perform the SMP migration. In summary, SMP migration
consists of the following tasks:

• Identifying the source server

• Selecting the volumes to migrate

• Testing the network connections

• Identifying the destination server

• Specifying destination disks and resizing NTFS partitions

• Selecting additional migration options, as necessary

• Confirming and performing the migration

• Reviewing the migration progress

For more information about the Migration Wizard, see the Migration Wizard page section in this
guide.

• View Status/Logs—This tab enables you to view the details and results of attempted migrations and to
delete migration results. For more information about viewing logs, see the Viewing migration logs
chapter in this guide.

• Upload Drivers—This tab displays the status of the iSCSI Initiator installed on the machine and provides
the option to upload PSP executables. For more information about this tab, see the Uploading drivers
chapter in this guide.

• Deploy Agent—This tab enables you to deploy the SMP VM Host and SMP Source Agents.
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4 Licensing SMP
This section provides information about SMP licensing.

Licensing SMP
One license key is required for each successful P2P, P2V, V2P, or V2V migration. SMP licenses, unlike other
ProLiant Essentials licenses, do not need to be deployed to servers.
SMP licenses are consumed after a successful migration.
For more information or to purchase licenses, see http://www.hp.com/go/migrate.

SMP licensing keys
To use P2P or SMP 2.x Subscription Keys in SMP, you must obtain a new license key from the HP Password
Center. Before calling, have the following information available:

• Product number

• Product name

• Number of license remaining

• Number of days remaining

To determine the number of licenses or days remaining prior to migrating, choose one of the following
procedures:

• P2P keys:
Launch the P2P application station.1.

2. Click the License tab.
3. From the license key list, you can view the information.

• SMP 2.x keys:
Log in to HP SIM.1.

2. Select Deploy→License Manager→HP Insight Server Migration software for ProLiant.
3. Click Manage Licenses.
4. From the license key list, you can view the information.

Licensing requirements
• A P2P or V2P migration can only be performed if at least one valid P2P license or SMP license for X2P

is available.

• A P2V or V2V migration can only be performed if at least one valid SMP license or SMP license for
X2V is available.

Licensing options
The licensing key list on the License tab reports the numbers and types of SMP license keys available and
enables you to enter new license keys.
The following types of SMP licenses are available for purchase:

• Subscription license—This type of SMP license enables the consumption of an unlimited number of
migrations for one year. The subscription period begins after the first license is consumed.

• Demo license—This type of SMP license enables a specific number of migrations for a specific period.
The subscription begins after the first license is consumed.

• Flexible Quantity license—This type of SMP license enables the consumption of a license from available
license keys each time a migration is successful.

If several keys are installed, the licenses are processed in the following order:
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• Subscription license

• Demo license

• Flexible Quantity license

NOTE: For P2V or V2V, if several SMP or X2V Flexible Quantity license keys are installed, the licenses
are processed in the following order:

• SMP license key

• X2V license key

For P2P or V2P, if several P2P or X2P Flexible Quantity license keys are installed, the license keys are
processed in the following order:

• P2P license key

• X2P license key

For more information or to purchase licenses, see http://www.hp.com/go/migrate.

Adding licenses
1. Click the License tab.
2. Enter a license key.
3. Click Add.

SMP 2.x and P2P license conversion
Existing SMP 2.x and P2P Supported Flexible Quantity licenses can be exported from old SMP or P2P
applications and imported to the new SMP application station. To simplify this process, SMP provides
command line import and export tools. The licenses are exported into an .xml file that can be imported to
the SMP application station.
These tools can be used on a CMS, P2P application station, or SMP application station.

CAUTION: Do not edit the .xml file generated by the license migrate tool.

When the previous SMP or P2P licenses are imported to a new SMP application station, they retain their
original product code. However, older SMP licenses imported are treated as X2V licenses.
Previous P2P licenses imported to the new SMP application station are treated as X2P licenses. Therefore,
older SMP licenses can only be used for P2V and V2V migrations. Older P2P licenses can now be used for
P2P and V2P migrations.
Previous SMP or P2P licenses cannot be added to SMP. The older licenses must be imported using the SMP
export and import tools.
To determine the number of licenses or days remaining prior to migrating, choose one of the following
procedures:

• P2P keys:
Launch the P2P application station.1.

2. Click the License tab.
3. From the license key list, you can view the information.

• SMP 2.x keys:
Log in to HP SIM.1.

2. Select Deploy→License Manager→HP Insight Server Migration software for ProLiant.
3. Click Manage Licenses.
4. From the license key list, you can view the information.

For contact information, see the “HP contact information” section in this guide.
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Migrating P2P licenses using License Migration Tool
If SMP is installed over an older P2P (SMP 2.x CMS) application, there is no need to use a migration tool
when installing SMP. The SMP License Manager detects existing P2P licenses and imports them into the SMP
during installation. Remaining Flexible Quantity, Demo, and Subscription licenses can be imported.
If SMP is installed on a separate system that is different from the older P2P (SMP 2.x CMS) application,
complete the following steps to migrate Flexible Quantity P2P licenses from another P2P application station:
1. Locate the migrateLM.tar file on SMP in the installed directory.
2. Copy the migrateLM.tar file to the older P2P application station.
3. Extract the migrateLM.tar file to the MigrateLM folder on the older P2P application station.
4. Verify that JRE is installed on the host and that the JAVA_HOME environment variable is set to the

installed JRE folder.
a. Install the latest JDK on an older P2P (SMP 2.x CMS) application station.
b. From the desktop, right-click My computer, and then select Properties. The Systems Properties

window appears.
i. Click the Advanced tab.
ii. Click Environment Variables.

c. In the User variables section, perform the following:
i. Click New.
ii. Enter JAVA_HOME in the Variable name box.
iii. Enter JRE installation folder in the Variable value box.
iv. Click OK.
The variable added appears in the System variables section.

d. In the System variables section, double-click the path you just added.
i. When the window appears, add a path for jre, bin, and jrewindows, and then click OK.
ii. To close the Systems Properties window, click OK.

5. From the command window, enter the following:
cd MigrateLM\bin

migratex2xlic.cmd p2p

6. Copy the generated migratedKeys.xml file to the SMP application station, into the following directory:
<SMP Installation Path>\bin

7. From the command line prompt on the SMP application station, access the <SMP Installation
Path>\bin directory, and then import the license by entering the following command:
importx2xlic.cmd

Migrating SMP 2.x licenses using License Migration Tool
1. Locate the migrateLM.tar file on SMP application station in the installed directory.
2. Copy the migrateLM.tar file to the CMS, where the older SMP 2.x CMS is installed.
3. Extract the migrateLM.tar file to the MigrateLM folder on the older SMP 2.x CMS.
4. Verify that JRE is installed on the host and that the JAVA_HOME environment variable is set to the

installed JRE folder.
a. Install the latest JDK on an older P2P (SMP 2.x CMS) application station.
b. From the desktop, right-click My computer, and then select Properties. The Systems Properties

window appears.
i. Click the Advanced tab.
ii. Click Environment Variables.

c. In the User variables section, perform the following:
i. Click New.
ii. Enter JAVA_HOME in the Variable name box.
iii. Enter JRE installation folder in the Variable value box.
iv. Click OK.
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The variable added appears in the System variables section.

d. In the System variables section, double-click the path you just added.
i. When the window appears, add a path for jre, bin, and jrewindows, and then click OK.
ii. To close the Systems Properties window, click OK.

5. From the command window, enter the following:
cd MigrateLM\bin

migratex2xlic.cmd smp

6. Copy the generated migratedKeys.xml file to the SMP application station, into the following directory:
<SMP Installation Path>\bin

7. From the command line prompt on the SMP application station, access the <SMP Installation
Path>\bin directory, and then to import the license, enter the following command: importx2xlic.cmd

NOTE: If SMP 2.x has been uninstalled on a CMS and SMP is installed on the same CMS, use the previous
steps to import any remaining licenses in to SMP.
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5 Using SMP for server migration
After source and destination server agents are launched, you can start a migration from an application
station or HP SIM CMS by choosing one of the following:

• To start the Migration Wizard from a stand-alone application station, double-click the SMP icon on the
desktop, or click Start→Programs→HP Insight Server Migration software for ProLiant→HP
Insight Server Migration software for ProLiant.

• To start the migration from HP SIM CMS, open HP SIM, select the source virtual machine or the source
server, and then from the main wizard select Deploy→SMP Migration Tools→<Type of
Migration>.

• To start the migration from HP SIM CMS using Quick Launch option, open HP SIM, select the source
virtual machine or source server, and then from the All Systems page in the HP SIM console, click
Quick Launch. Quick Launch displays the available operations with the selected source virtual machine
or source server.

IMPORTANT: P2P and P2V can be launched only for ProLiant servers that have been properly discovered
in HP SIM. If you are migrating any physical servers other than a ProLiant, launch the SMP stand-alone
application.

Concurrent and queued migrations
Concurrent migrations occur when two migrations can be run simultaneously from the same SMP application
station.
SMP enables concurrent migrations to be launched from the same SMP application station. After you start
a migration, the Start New Migration button appears on page 8 of the Migration Wizard. This launches
the Migration Wizard to start a new migration.
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The following conditions must be met to start a concurrent migration:

• The SMP Source Agent or Destination Boot CD should not be part of other running migrations. The
Wizard blocks you from triggering multiple migrations from the same SMP Source Agent or to the same
SMP Boot CD.

• If a Destination VM Host Agent is used, the Migration Wizard enables you to start multiple migrations
to the same VM Host Agent. The migration is queued and starts running only after the other migrations
on the VM Host Agent are completed.

NOTE: Even though SMP enables you to concurrently migrate multiple source servers to the same host
(X2V), HP does not recommended this type of migration because it affects the time required for the migration.
Additionally, SMP enables concurrent X2V migrations to agent-less hypervisors. HP does not recommend
this type of migration because it also affects the time required for the migration.

Table 5-1 Concurrent and queued migrations

QueuedConcurrentMigration

Not supported.Supported if the source server and target server are not a part of any
other running migration

P2P

Supported if the source is not a part of another
running migration and the destination virtual
machine host is used as a source in another
running migration.

Supported if the source server is not a part of any other running
migration and the destination virtual machine host is not a destination
in another running migration.

P2V

Not supported.Supported if the source server and destination server are not a part
of any running migration.

V2P

Supported if the source is not a part of another
running migration and the destination virtual
machine host is used as a source in another
running migration.

Supported if the source server is not a part of any other running
migration and the destination virtual machine host is not a destination
in another running migration.

V2V

Migration Wizard page
The Migration Wizard page lists the types of migrations and operating systems that are supported. When
a migration type is selected, the steps to perform the migration and corresponding images appear.

To configure the Migration Wizard screen to appear when the SMP is opened, on the Overview page,
select the Start the Migration Wizard when opening this application box.
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Physical-to-ProLiant (P2P) migrations for Windows
Preparing for a P2P migration

The following sections list prerequisites for a Windows P2P migration.
If you use a firewall, see the Configuring SMP with a firewall section in this guide.

Source physical machine prerequisites

• A valid network connection must exist between the source and destination server.

• The source server must contain an active boot partition to be migrated.

• Complete any pending reboots and software installations on the source machine before initiating a
migration to prevent interrupting the migration process.

• Temporarily disable any antivirus software autoscans on the source machine to prevent interrupting the
migration process. Re-enable the antivirus software after the migration.

• To verify that the disks are not corrupted, run FSCK on the source physical machine before initiating a
migration operation.

• Verify that all hard drives on the source physical machine are correctly initialized (disk signature written).

• Verify that all partitions on the source physical machine have a valid file system and are in a healthy
state.

• Disable all applications and background services on the source machine. After the migrated machine
has synchronized with the new hardware and is assigned a unique network identity, appropriate
applications can be manually re-enabled and configured for the new environment.

• Temporarily disable HP Management Agents on the source physical machine.

• During migration, the SMP Agent initiates an operating system reboot on the source physical machine.
Verify that the operating system is on the first boot order. If not, then manually change the boot order
by editing the /boot/grub/menu.lst file. The SMP application supports migration of source physical
machines that have operating systems installed on the primary drive (Hard Disk0) and the primary drive
loaded first in the boot order.

SMP application station prerequisites

• Verify that Microsoft iSCSI Initiator 2.06, 2.07, or 2.08, which is required for primary mass storage
driver injection, is installed and running on the SMP application station. If iSCSI Initiator is not installed,
then download and install it from http://www.microsoft.com. Other versions of the initiator, including
later versions, cannot be used with this version of SMP.

• Valid migrated previous P2P licenses or SMP X2P or X2X license keys are required on the application
station. Verify that adequate licenses exist by selecting the License tab in the SMP application station.

• Verify that no virtualization software is installed on the SMP application station.

• To prevent interrupting the migration process, temporarily disable any antivirus software autoscans on
the SMP application station. Re-enable the antivirus software after the migration.

• Disable all the Windows network drive mappings to the source physical machine in the SMP application
station.

• Verify that the SMP application station Windows operating systems version is greater than or equal to
the source physical machine Windows operating system version.

• Verify that the SMP application station Windows operating system is configured for NTFS.

Destination physical machine prerequisites

• The primary storage controller must be configured with drives attached.

• The destination server must be booted to SMP Boot CD and running SMP Agent.
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Performing a P2P migration

CAUTION: If the SMP application station shuts down or fails during any migration, then the migration
being performed fails. Availability of application station during complete migration cycle is required for
successful migration.

To start the P2P Migration Wizard:
1. If you are performing a migration from a stand-alone SMP application station:

a. From the desktop, access the SMP Migration Wizard by clicking the SMP application icon.
b. From the Overview page, click the Migration Wizard tab.

c. Choose the Windows migration type.
d. Click Physical to ProLiant Migration (P2P), and then click Next.

2. If you are performing a migration from HP SIM CMS, choose one of the following options:

• To launch SMP using the HP SIM menu, select Deploy→SMP Migration Tools→ Physical to
ProLiant (P2P), select Windows, and then follow the instructions to launch SMP Migration Tools.

• To launch SMP using Quick Launch, select the proper source server or virtual machine in HP SIM,
scroll over Quick Launch, and then select Physical to ProLiant (P2P).

3. IMPORTANT: When you access the Migration Wizard tab and no license key is available, you are
prompted to add a license key. For more information about licensing, see Licensing SMP.
For additional information, or to purchase licenses, see http://www.hp.com/go/migrate.

NOTE: If you are migrating a server with an older version of the SMP Application Station software
installed, stop the SMP services before installing the SMP Source Agent.

1. Enter the source Server Name or four-part IP address.
2. Select whether SMP must deploy SMP Source Agent on the source server. If you select this option,

you must provide the source server administrative credentials.
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3. Click Next.
4. To install SMP Source Agent on the source server, select the Deploy SMP Source Agent checkbox,

enter the User name and Password, and then click Next.
5. If SMP Source Agent is already running on the specified source server, make sure the Deploy SMP

Source Agent checkbox is cleared, and then click Next. The wizard verifies if SMP Source Agent
is already running on the specified source server.

NOTE: Source agents cannot be deployed to Windows 2008 servers using the Deploy Agent
tab on the application station wizard. You must either manually copy the hpsmpagent.exe from
the <installation dir>\Agents\SMP folder to the source server or connect the SMP installation
CD to the source server, and then install the SMP Source Agent by clicking Install SMP Source
Agent in the auto run window of the SMP application.

4. Select the volumes to be migrated. Volumes marked as active are selected by default. You cannot migrate
or select unsupported file systems.
The boot partition must be migrated. The boot partition is contained in an active volume. If only one
active volume exists, by default it contains the boot partition and cannot be cleared. If multiple active
volumes exist, ensure that the volume containing the active boot partition (which contains the boot.ini,
NTLDR, and NTDETECT.com files) is migrated to the target boot disk. Additional bootable partitions
might be contained in other active volumes, but the partitions do not need to be migrated. The operating
system must be stored on the boot disk and loaded using NT Boot Loader (NTLDR).
Volumes on dynamic disks are migrated to partitions on basic disks. Volumes that span multiple dynamic
disks (including spanned, striped, mirrored, and RAID 5 volumes) are migrated to a single contiguous
partition. Volumes stored on a common source disk must be stored on a common destination disk. You
can only resize NTFS partitions.
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The Computed Destination Server Disk Requirement section lists the disks required on the destination
server to support migrated volumes. The Size, Minimum Destination Size, and Maximum Destination
Size values in the lower table are updated dynamically as volumes in the upper table are selected or
cleared for migration. A message appears under the table, indicating the number of logical units that
must be created on the destination server. The entry in the Minimum Destination Size column is
estimated, based on reducing eligible volumes to their minimum size during migration. Additional space
might be required to accommodate disk geometry differences.

5. Select how the destination server is booted:

• Manual - Boot destination server myself—If the destination server is booted to the SMP Boot
CD and the destination agent is launched, select this option.

• Auto Boot - Let SMP boot the destination server—If the destination server is not booted to the
SMP Boot CD and the destination agent is not launched, select this option.
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The Next and Previous buttons are disabled during the reboot. To view the booting process of the
destination server, click Launch iLO, and then open the remote console.
To cancel the boot process and power down the destination server, click Cancel Booting.

6. The Next and Previous buttons are disabled during the reboot. To view the booting process of the
destination server, click Launch iLO, and then open the remote console.
To cancel the boot process and power down the destination server, click Cancel Booting.

7. Test the network connections and latency between the source-to-destination server and the
application-station-to-destination server. The results of a 2-second test initially appear.

8. To perform additional tests, select a test time in the Test network connections section, and then click
Test. The following test times are available:

• 2 seconds

• 5 seconds

• 10 seconds

• 30 seconds

• 60 seconds

If the source-to-destination or application-station-to-destination connection cannot be established, the
Next button is disabled. Ensure that ports 51125 and 51126 are open between source and destination
servers.
If the source-to-destination or application-station-to-destination connection is established but the network
test reports a transfer speed below 250 kbps, the Next button is disabled.
If the source-to-destination or application-station-to-destination connection is established and the network
test reports a transfer speed of at least 250 kbps, the Next button is enabled.

CAUTION: If the application-station-to-destination latency is less than 125 milliseconds, continue with
the migration. Latency exceeding 125 milliseconds during driver installation might cause the driver
installation to fail. Before continuing with the migration, verify the proper duplex setting, and then check
the latency again.

9. Click Next.
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10. Map source disks to destination disks. Ensure that migrated volumes fit on their mapped destination
disks. Select the size of the migrated volumes on the destination server.
The boot partition must be migrated to the first volume of the boot controller. If one active volume is
migrated and the boot controller on the destination server can be identified, the boot partition is migrated
to the first volume of the boot controller. If more than one active volume is migrated or the boot controller
cannot be identified, verify that the boot partition is migrated to the first volume of the boot controller.
Migrated volumes are converted to partitions on basic disks. Boot partitions that span multiple dynamic
disks on the source server are migrated to a single contiguous partition on a basic disk. Volumes stored
on a common source disk must also be stored on a common destination disk. Click Next.
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Some of the columns and rows from the Assign Disks and Resize NTFS Volumes table include:

• Minimum Destination Size—This column displays the minimum size that a partition or disk can be
resized to for the destination disk.

• Destination Size—This column displays the partition or disk resize on the destination disk.

• Migration Overhead—This row displays the additional space that must be reserved on the
destination disk to accommodate disk geometry differences.

• Unallocated—This row displays available space remaining on the destination disk after the migration
is complete. The value of Unallocated should be zero or a positive number to proceed to the Next
wizard page.

• Disk 0, Disk 1, Disk2, and so on—For each row, the value in the Minimum Destination Size and
Destination Size columns represents the sum of partition sizes and migration overhead space for
the disk.

11. Choose from the following options:

• Select whether SMP must perform disk-error checks on the source server before migration. By
default, the Use CHKDSK to detect and fix errors on all source disks prior to migration
checkbox is selected.

• Select the reboot action that the destination server must perform by choosing one of the following
options:

• The destination server must be powered off after migration is complete.

• The destination server must be rebooted after migration is complete.

• If the destination server is selected to reboot upon completion, additional configuration options
are available. If PSP executables are available on the application station and selected, the network
settings on the destination can be configured. For information on how to upload PSP executables,
see the Upload Drivers section.

• Select a PSP to install on the destination server and configure a static IP for each destination NIC
as needed.

NOTE: If a DHCP-acquired IP address is needed, do not enter any IP address addresses.

12. Click Next.
13. Review and confirm the migration details, and then click Begin Migration.
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When you click Begin Migration, the SMP Agent performs a final network check. If the network check
fails, an error message appears. Fix the network issue, and then to continue the migration process, click
Begin Migration again.

14. Review the migration progress details. To cancel the migration, click Cancel. After the entry in the
Job Status field indicates the migration has been canceled, reboot the source and destination servers.

15. After the migration is complete, to perform additional migrations, click Begin New Migration. The first
screen of the Migration Wizard appears.
Additional migrations can be set up at the same time the current migration is performed.
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P2P post-migration tasks
After you complete a P2P migration, perform the following steps:
1. Log in with administrative rights.
2. At each of the Welcome to the Found New Hardware wizard screens, click Cancel.
3. When prompted to reboot the system at the System Settings Change Window, click No.
4. Install the latest PSP (if this option was not selected during the P2P install). The PSP is located on the

SmartStart CD. To successfully install the ProLiant Support Pack, SNMP service must be installed. To
install SNMP service, see your operating system documentation.
For more detailed steps on installing the PSP using Windows 2000, see the Windows 2000 post-migration
steps section in this guide, and for Windows 2003, see the Windows 2003 and Windows 2008
post-migration steps section in this guide.

5. View the Windows event log on the destination server and disable any services or drivers that might
have failed.

6. If necessary, verify the network connections. If NIC teaming is required on the destination server, then
NIC teaming must be re-established on the destination server after the migration and installation
of the PSP.

7. If the source and destination servers must be on the network at the same time:
a. Change the host name of either server or consider reconfiguring the applications.
b. If the IP addresses are static, reassign them.

8. (Optional) Reassign drive letters to former dynamic disk partitions.
9. (Optional) Convert basic disks to dynamic disks. During migration, all dynamic disks are migrated to

the destination server as basic disks. Therefore, if dynamic disks are preferred on the destination server,
then basic disks can be manually converted back to dynamic disks.

10. Edit the boot.ini file, and update the boot entry with necessary switches. The /bootlog and /sos
options can be removed. For proper booting of the destination server, the SMP application adds a new
entry to the boot.ini file. The original boot entry is preserved with a different name. The new boot
entry contains functions to make disk checking more informative and to increase logging during the
boot operation. These functions help you determine the success of the migration and can be disabled
at any time after migration by modifying the boot.ini file.
Additionally, to retain the original boot parameters, copy all valid flags from the original entry and
consider other appropriate boot flags as applicable, such as adding the /3GB flag only if the destination
physical machine is configured with sufficient RAM.
Then delete the original (preserved) entry, which has been struck through in the following example.

[boot loader]

default=multi(0)disk(0)rdisk(0)partition(1)\WINDOWS

timeout=30

[operating systems]

multi(0)disk(0)rdisk(0)partition(1)\WINDOWS=”Windows Server 2003, Enterprise” /sos /bootlog
/noexecute=optout /fastdetect

multi(0)disk(0)rdisk(0)partition(1)\WINDOWS=”HP SMP Preserved: Windows Server 2003, Enterprise”
/userva=3030 /3gb /noexecute=optout /fastdetect

11. If the Windows license is not a volume license, then reactivate it.
12. The mouse and keyboard might not be immediately active after the migration. Wait until all required

drivers are automatically installed by the guest operating system, and then reboot when prompted.

Physical-to-ProLiant (P2P) migrations for Linux
Preparing for a P2P migration

The following sections list prerequisites for a P2P migration.
If you use a firewall, see the Configuring SMP with a firewall section in this guide.
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Source physical machine prerequisites

• A valid network connection must exist between the source and destination server.

• The source server must contain an active boot partition to be migrated.

• Complete any pending reboots and software installations on the source machine before initiating a
migration to prevent interrupting the migration process.

• Temporarily disable any antivirus software autoscans on the source machine to prevent interrupting the
migration process. Re-enable the antivirus software after the migration.

• To verify that the disks are not corrupted, run a disk defragmenter on the source physical machine
before initiating a migration operation.

• Verify that all hard drives on the source physical machine are correctly initialized (disk signature written).

• Verify that all partitions on the source physical machine have a valid file system and are in a healthy
state.

• Disable all applications and background services on the source machine. After the migrated machine
has synchronized with the new hardware and is assigned a unique network identity, appropriate
applications can be manually re-enabled and configured for the new environment.

• Temporarily disable HP Management Agents on the source physical machine.

• During migration, the SMP Agent initiates an operating system reboot on the source physical machine.
Verify that the operating system is on the first boot order. If not, then manually change the boot order
by editing the [system drive]\boot.ini file or by using the bootcfg.exe tool. The SMP application
supports migration of source physical machines that have operating systems installed on the primary
drive (Hard Disk0) and the primary drive loaded first in the boot order.

• Record the drive letter or mount point to disk-partition mapping for dynamic disk partitions before
performing the migration. Any simple (non-extended) dynamic disk partitions are converted to basic
disk partitions. The mapped drive letters might have to be manually reassigned after migration.

NOTE: Bad blocks on Linux file systems are not supported by SMP. To verify that the source file system
does not have bad blocks, run file system-specific tools.

SMP application station prerequisites

• Verify that Microsoft iSCSI Initiator 2.06, 2.07, or 2.08, which is required for primary mass storage
driver injection, is installed and running on the SMP application station. If iSCSI Initiator is not installed,
then download and install it from http://www.microsoft.com. Other versions of the initiator, including
later versions, cannot be used with this version of SMP.

• Valid migrated previous P2P licenses are required on the application station. Verify that adequate
licenses exist by selecting the License tab in the SMP application station.

• Verify that no virtualization software is installed on the SMP application station.

• To prevent interrupting the migration process, temporarily disable any antivirus software autoscans on
the SMP application station. Re-enable the antivirus software after the migration.

Destination physical machine prerequisites

• The primary storage controller must be configured with drives attached.

• The destination server must be booted to SMP Boot CD and running SMP Agent.

Performing a P2P migration

CAUTION: If the SMP application station shuts down or fails during any migration, then the migration
being performed fails. Availability of application station during complete migration cycle is required for
successful migration.

To start the P2P Migration Wizard:
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1. If you are performing a migration from a stand-alone SMP application station:

• From the desktop, access the SMP Migration Wizard by clicking the SMP application icon.

• From the Overview page, click the Migration Wizard tab.

• Choose the Linux migration type.

• Click Physical to ProLiant Migration (P2P), and then click Next.

2. IMPORTANT: When you access the Migration Wizard tab and no license key is available, you are
prompted to add a license key. For more information about licensing, see Licensing SMP.
For additional information, or to purchase licenses, see http://www.hp.com/go/migrate.

1. Enter the source Server Name or four-part IP address.
2. Select whether SMP must deploy SMP Source Agent on the source server. If you select this option,

you must provide the source server administrative credentials.
3. Click Next.
4. To install SMP Source Agent on the source server, verify that PermitRootLogin and

PasswordAuthentication are set to yes in the /etc/sshd/sshd_config file, and then
verify the sshd service is running. On the Migration Wizard, select the Deploy SMP Source Agent
checkbox, enter the User name and Password, and then click Next.
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NOTE: For Linux SMP Source Agent deployments, verify SELinux is in passive mode on the source
server.

5. If SMP Source Agent is already running on the specified source server, make sure the Deploy SMP
Source Agent checkbox is cleared, and then click Next. The wizard verifies if SMP Source Agent
is already running on the specified source server.

CAUTION: The agent deployment automatically stops the Linux source server firewall and Security
Enforcing Linux (SELinux).

3. Select the volumes to be migrated. Volumes marked as active are selected by default. You cannot migrate
or select unsupported file systems.
The boot, swap, and root partitions must be migrated. By default, the active boot partition on the
specified source server is selected for migration. You must select OS-critical file systems for migration.
You can choose additional file systems for migration.
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NOTE: You cannot migrate a partition acting as a Physical Volume (PV) for a Volume Group (VG).
However, if you select a Logical Volume for migration in the Select Volumes To Be Migrated section,
the required VG structure is created on the destination server.

The Computed Destination Server Disk Requirement section lists the disks required on the destination
server to support migrated volumes. The Size values in the lower table are updated dynamically as
volumes in the upper table are selected or cleared for migration. A message appears under the table,
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indicating the number of logical units that must be created on the destination server. Additional space
might be required to accommodate disk geometry differences.

4. Manual - Boot destination server myself—If the destination server is booted to the SMP Boot CD
and the destination agent is launched, select this option.

5. Auto Boot - Let SMP boot the destination server—If the destination server is not booted to the SMP
Boot CD and the destination agent is not launched, select this option.

6. The Next and Previous buttons are disabled during the reboot. To view the booting process of the
destination server, click Launch iLO, and then open the remote console.
To cancel the boot process and power down the destination server, click Cancel Booting.

7. Test the network connections and latency between the source-to-destination server and the
application-station-to-destination server. The results of a 2-second test initially appear.

8. To perform additional tests, select a test time in the Test network connections section, and then click
Test. The following test times are available:
If the source-to-destination or application-station-to-destination connection cannot be established, the
Next button is disabled. Ensure that ports 51125 and 51126 are open between source and destination
servers.
If the source-to-destination or application-station-to-destination connection is established but the network
test reports a transfer speed below 250 kbps, the Next button is disabled.
If the source-to-destination or application-station-to-destination connection is established and the network
test reports a transfer speed of at least 250 kbps, the Next button is enabled.

CAUTION: If the application-station-to-destination latency is less than 125 milliseconds, continue with
the migration. Latency exceeding 125 milliseconds during driver installation might cause the driver
installation to fail. Before continuing with the migration, verify the proper duplex setting, and then check
the latency again.

9. Click Next.
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10. Map source disks to destination disks. Ensure that migrated disks fit on their mapped destination disks.
The boot partition must be migrated to the default boot disk of the boot controller. If one active volume
is migrated and the boot controller on the destination server can be identified, the boot partition is
migrated to the default boot disk of the boot controller. If more than one active partition is migrated or
the boot controller cannot be identified, verify that the boot partition is migrated to the default boot disk
of the boot controller.
Volumes stored on a common source disk are stored on a common destination disk. You can migrate
a source disk with one or more source volume groups (VGs) to a single destination disk, provided there
is enough space on the destination. However, you must select the Logical Volume Managers (LVMs) to
be migrated under the logical volume table. Click Next.
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Some of the columns and rows from the Assign Disks table include:

• Minimum Destination Size—This column displays the minimum size that a partition or disk can be
resized to for the destination disk.

• Destination Size—This column displays the partition or disk resize on the destination disk.

• Migration Overhead—This row displays the additional space that must be reserved on the
destination disk to accommodate disk geometry differences.

• Disk 0, Disk 1, Disk2, and so on—For each row, the value in the Minimum Destination Size and
Destination Size columns represents the sum of partition sizes and migration overhead space for
the disk.

11. Choose from the following options:

• Select whether SMP must perform disk-error checks on the source server before migration. By
default, the Use FSCK to detect and fix errors on all source disks prior to migration checkbox
is selected.

• Select the reboot action that the destination server must perform by choosing one of the following
options:

• The destination server must be powered off after migration is complete.

• The destination server must be rebooted after migration is complete.
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12. Click Next.
13. Review and confirm the migration details, and then click Begin Migration.
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When you click Begin Migration, the SMP Agent performs a final network check. If the network check
fails, an error message appears. Fix the network issue, and then to continue the migration process, click
Begin Migration again.

14. Review the migration progress details. To cancel the migration, click Cancel. After the entry in the
Job Status field indicates the migration has been canceled, reboot the source and destination servers.

15. After the migration is complete, to perform additional migrations, click Begin New Migration. The first
screen of the Migration Wizard appears.
Additional migrations can be set up at the same time the current migration is performed.

P2P post-migration tasks
After you complete a P2P migration, perform the following steps:
1. Log in with administrative rights.
2. At each of the Welcome to the Found New Hardware wizard screens, click Cancel.
3. When prompted to reboot the system at the System Settings Change Window, click No.
4. Install the latest PSP (if this option was not selected during the P2P install). The PSP is located on the

SmartStart CD. To successfully install the ProLiant Support Pack, SNMP service must be installed. To
install SNMP service, see your operating system documentation.

5. If necessary, verify the network connections. If NIC teaming is required on the destination server, then
NIC teaming must be re-established on the destination server after the migration and installation
of the PSP.

6. If the source and destination servers must be on the network at the same time:
a. Change the host name of either server or consider reconfiguring the applications.
b. If the IP addresses are static, reassign them.

7. (Optional) Reassign drive letters to former dynamic disk partitions.
8. (Optional) Convert basic disks to dynamic disks. During migration, all dynamic disks are migrated to

the destination server as basic disks. Therefore, if dynamic disks are preferred on the destination server,
then basic disks can be manually converted back to dynamic disks.

9. Edit the boot.ini file, and update the boot entry with necessary switches. The /bootlog and /sos
options can be removed. For proper booting of the destination server, the SMP application adds a new
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entry to the boot.ini file. The original boot entry is preserved with a different name. The new boot
entry contains functions to make disk checking more informative and to increase logging during the
boot operation. These functions help you determine the success of the migration and can be disabled
at any time after migration by modifying the boot.ini file.
Additionally, to retain the original boot parameters, copy all valid flags from the original entry and
consider other appropriate boot flags as applicable, such as adding the /3GB flag only if the destination
physical machine is configured with sufficient RAM.

10. If the license is not a volume license, then reactivate it.
11. The mouse and keyboard might not be immediately active after the migration. Wait until all required

drivers are automatically installed by the guest operating system, and then reboot when prompted.

Physical-to-virtual (P2V) migrations
A P2V migration enables a source physical machine to be migrated to a virtual machine guest on a Microsoft
Virtual Server, Hyper-V, VMware, or HP integrated Citrix XenServer virtual machine host.

Preparing for a P2V migration
The following sections list prerequisites for a P2V migration.
If you use a firewall, see the Configuring SMP with a firewall section in this guide.

Source physical machine prerequisites

• A valid network connection must exist between the source and destination server.

• The source server must contain an active boot partition to be migrated.

• Complete any pending reboots and software installations on the source machine before initiating a
migration to prevent interrupting the migration process.

• Temporarily disable any antivirus software autoscans on the source machine to prevent interrupting the
migration process. Re-enable the antivirus software after the migration.

• To verify that the disks are not corrupted, run FSCK on the source physical machine before initiating a
migration operation.

• Verify that all hard drives on the source physical machine are correctly initialized (disk signature written).

• Verify that all partitions on the source physical machine have a valid file system and are in a healthy
state.

• Disable all applications and background services on the source machine. After the migrated machine
has synchronized with the new hardware and is assigned a unique network identity, appropriate
applications can be manually re-enabled and configured for the new environment.

• Temporarily disable HP Management Agents on the source physical machine.

• During migration, the SMP Agent initiates an operating system reboot on the source physical machine.
Verify that the operating system is on the first boot order. If not, then manually change the boot order
by editing the /boot/grub/menu.lst file. The SMP application supports migration of source physical
machines that have operating systems installed on the primary drive (Hard Disk0) and the primary drive
loaded first in the boot order.

SMP application station prerequisites

• Verify that Microsoft iSCSI Initiator 2.06, 2.07, or 2.08, which is required for primary mass storage
driver injection, is installed and running on the SMP application station. If iSCSI Initiator is not installed,
then download and install it from http://www.microsoft.com. Other versions of the initiator, including
later versions, cannot be used with this version of SMP.

• Valid migrated previous P2P licenses or SMP X2P or X2X license keys are required on the application
station. Verify that adequate licenses exist by selecting the License tab in the SMP application station.

• Verify that no virtualization software is installed on the SMP application station.

• To prevent interrupting the migration process, temporarily disable any antivirus software autoscans on
the SMP application station. Re-enable the antivirus software after the migration.
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• Disable all the Windows network drive mappings to the source physical machine in the SMP application
station.

• Verify that the SMP application station Windows operating systems version is greater than or equal to
the source physical machine Windows operating system version.

• Verify that the SMP application station Windows operating system is configured for NTFS.

Destination virtual machine host or virtual machine prerequisites
The following prerequisites are for target virtual machine hosts in a P2V migration:

• If the virtual machine host is agent-based, the SMP VM Hosts Agent must be deployed and running on
the virtual machine host before you start the migration.

• If the virtual machine host is agent-less, you can select one of the following:

Let SMP create the virtual machine automatically, and then boot it using the SMP VM Boot CD for
virtual machines.

•

• Create the virtual machine manually, and then boot the virtual machine manually using the SMP
VM Boot CD for virtual machines.

• Verify that the destination virtual machine host has sufficient system resources, including processor,
memory, and disk space to host the migrated virtual machine guest.

• Temporarily disable any antivirus software autoscans on the destination virtual machine host to prevent
interrupting the migration process. Re-enable the antivirus software after the migration.

Performing a P2V migration

CAUTION: If the SMP application station shuts down or fails during any migration, then the migration
being performed fails. Availability of application station during complete migration cycle is required for
successful migration.

To start the P2V Migration Wizard:
1. If you are performing a migration from a stand-alone SMP application station:

• From the desktop, access the SMP Migration Wizard by clicking the SMP application icon.

• From the Overview page, click the Migration Wizard tab.
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• Choose the Windows migration type.

• Click Physical to Virtual Migration (P2V), and then click Next.

2. If you are performing a migration from HP SIM CMS, choose one of the following options:

• To launch SMP using the HP SIM menu, select Deploy→SMP Migration Tools→ Physical to
Virtual (P2V), select Windows, and then follow the instructions to launch SMP Migration Tools.

• To launch SMP using Quick Launch, select the proper source server or virtual machine in HP SIM,
scroll over Quick Launch, and then select Physical to Virtual (P2V).

3. IMPORTANT: When you access the Migration Wizard tab and no license key is available, you are
prompted to add a license key. For more information about licensing, see Licensing SMP.
For additional information, or to purchase licenses, see http://www.hp.com/go/migrate.

NOTE: If you are migrating a server with an older version of the SMP Application Station software
installed, stop the SMP services before installing the SMP Source Agent.

1. Enter the source Server Name or four-part IP address.
2. Select whether SMP must deploy SMP Source Agent on the source server. If you select this option,

you must provide the source server administrative credentials.
3. Click Next.
4. To install SMP Source Agent on the source server, select the Deploy SMP Source Agent checkbox,

enter the User name and Password, and then click Next.
5. If SMP Source Agent is already running on the specified source server, make sure the Deploy SMP

Source Agent checkbox is cleared, and then click Next. The wizard verifies if SMP Source Agent
is already running on the specified source server.

NOTE: Source agents cannot be deployed to Windows 2008 servers using the Deploy Agent
tab on the application station wizard. You must either manually copy the hpsmpagent.exe from
the <installation dir>\Agents\SMP folder to the source server or connect the SMP installation

Physical-to-virtual (P2V) migrations 69

http://www.hp.com/go/migrate


CD to the source server, and then install the SMP Source Agent by clicking Install SMP Source
Agent in the auto run window of the SMP application.

4. Select the volumes to be migrated. Volumes marked as active are selected by default. You cannot migrate
or select unsupported file systems.
The boot partition must be migrated. The boot partition is contained in an active volume. If only one
active volume exists, by default it contains the boot partition and cannot be cleared. If multiple active
volumes exist, ensure that the volume containing the active boot partition (which contains the boot.ini,
NTLDR, and NTDETECT.com files) is migrated to the target boot disk. Additional bootable partitions
might be contained in other active volumes, but the partitions do not need to be migrated. The operating
system must be stored on the boot disk and loaded using NT Boot Loader (NTLDR).
Volumes on dynamic disks are migrated to partitions on basic disks. Volumes that span multiple dynamic
disks (including spanned, striped, mirrored, and RAID 5 volumes) are migrated to a single contiguous
partition. Volumes stored on a common source disk must be stored on a common destination disk. You
can only resize NTFS partitions.
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The Computed Destination Server Disk Requirement section lists the disks required on the destination
server to support migrated volumes. The Size, Minimum Destination Size, and Maximum Destination
Size values in the lower table are updated dynamically as volumes in the upper table are selected or
cleared for migration. A message appears under the table, indicating the number of logical units that
must be created on the destination server. The entry in the Minimum Destination Size column is
estimated, based on reducing eligible volumes to their minimum size during migration. Additional space
might be required to accommodate disk geometry differences.

5. Select the appropriate destination virtualization layer in the Select Virtualization Layer box.

• Agent-based hypervisors—Enter the destination virtual machine host name or IP address, and then
click Next.
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NOTE: The VM Host agent must be deployed on the destination VM Host before completing this
step.

• Agent-less hypervisors—Enter the destination virtual machine host name or IP address, and then
enter the host administrative credentials.

• If the destination virtual machine was booted with the SMP Virtual Boot CD, select
Manual Boot - Manually create VM through VM Host's Infrastructure Client. Enter the
four-part IP address of the destination virtual machine, User name, and Password, and
then click Next.
The Virtual Boot CD can be found at <installation
directory>\webserver\webapps\smpui\smpbootcd-v-3.70.iso.
For more information about manually booting a virtual machine using the SMP Virtual Boot
CD, see Prerequisites for manually creating and booting a destination virtual machine.
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• If the destination virtual machine is not created, select Auto Boot - Automatically have VM
created through SMP migration. Enter the four-part VM Pre-boot IP address, Subnet
Mask, and Gateway (optional) to be assigned to the virtual machine, and then click Next.
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6. Specify the destination disks, and then select the NTFS partitions to be resized.
By default, this page includes a table that displays all disks present on the destination virtual machine,
with source disk, disk format, size, and destination disk information.
The following screen appears when the manually booted destination is selected for agent-less virtual
machine hosts.

The following screen appears when the automatically booted destination is selected for agent-less virtual
machine hosts.

If you are migrating to an agent-based virtual machine host or migrating to an agent-less virtual machine
host that is automatically booted with the SMP Virtual Boot CD:
a. Enter information in the Guest Display Name, Guest Memory, and Guest Storage Location

boxes.
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b. Select the storage location (if applicable).

• If you are migrating to an agent-based virtual machine, to browse for guest storage location
information, click Browse. A selection window appears where you can enter the destination
folder information or select a remote folder. Click OK.

NOTE: If the destination virtual machine host is ESX 3.x, you must create a new folder.

• If migrating to an agent-less virtual machine, select the guest storage location from the list.
Click Next.

If the destination virtual machine is manually booted with the SMP Virtual Boot CD, select the
destination disk, and then click Next.

c. Some of the columns and rows from the Assign Disks and Resize NTFS Volumes table include:

• Minimum Destination Size—This column displays the minimum size to which a partition or
disk can be resized for the destination disk.

• Destination Size—This column displays the desired partition resize or disk resize on the
destination disk.

• Migration Overhead—This row displays the additional space that must be reserved on the
destination disk to accommodate disk geometry differences.

• Unallocated—This row displays the available space remaining on the destination disk after
the migration is complete. To proceed to the Next wizard page, the value of Unallocated must
either be 0 (zero) or a positive number.

For migrations to agent-less virtual hosts and Auto Boot - Let SMP create the VM selected in step 3,
when you click Next, SMP connects to the destination virtual machine host to create the virtual machine
with the required configurations. The virtual machine is then booted with the SMP Virtual Boot CD, which
can take a few minutes. After the virtual machine is booted, the application station connects to the Agent
and progresses to the next screen.

7. Test the network connections and latency between the source-to-destination server and the
application-station-to-destination server. The results of a 2-second test initially appear.

8. To perform additional tests, select a test time in the Test network connections section, and then click
Test. The following test times are available:

• 2 seconds

• 5 seconds

• 10 seconds
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• 30 seconds

• 60 seconds

If the source-to-destination or application-station-to-destination connection cannot be established, the
Next button is disabled. Ensure that ports 51125 and 51126 are open between source and destination
servers.
If the source-to-destination or application-station-to-destination connection is established but the network
test reports a transfer speed below 250 kbps, the Next button is disabled.
If the source-to-destination or application-station-to-destination connection is established and the network
test reports a transfer speed of at least 250 kbps, the Next button is enabled.

CAUTION: If the application-station-to-destination latency is less than 125 milliseconds, continue with
the migration. Latency exceeding 125 milliseconds during driver installation might cause the driver
installation to fail. Before continuing with the migration, verify the proper duplex setting, and then check
the latency again.

9. Click Next.

10. Select the post-migration tasks, and then click Next.

• Select whether the SMP application must perform disk-error checks on the source server before
migration. By default, the Use CHKDSK to detect and fix errors on all source disks prior to
migration checkbox is selected.

• A reboot or shutdown option is not available for the destination virtual machine for X2V migrations
when the option to manually create and the boot the destination virtual machine is selected in
step 3 of the Migration Wizard. After the migration is completed, manually reboot the destination
virtual machine.
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11. Review and confirm the migration details, and then click Begin Migration.
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When you click Begin Migration, the SMP Agent performs a final network check. If the network check
fails, an error message appears. Fix the network issue, and then to continue the migration process, click
Begin Migration again.

12. Review the migration progress details. To cancel the migration, click Cancel. After the entry in the
Job Status field indicates the migration has been canceled, reboot the source and destination servers.
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P2V post-migration tasks
After you complete a P2V migration, perform one of the following based on your hypervisor type, and then
perform the tasks in the seven steps that follow on the migrated virtual machine guest:

• Agent-less hypervisor—If you performed a migration to an agent-less hypervisor where you manually
booted the virtual machine using the SMP VM Boot CD, you must disconnect the SMP VM Boot CD,
and then manually reboot the virtual machine.

• Agent-based hypervisor—If you performed a migration to an agent-based hypervisor:
Access the destination virtual machine host remote console and manually shut down the virtual
machine.

1.

2. Perform a network configuration for the migrated virtual machine guest. To do so, access the
destination virtual machine host remote console to configure the network connections for the
migrated virtual machine guest.

3. For Windows 2000 Server migrations to HP integrated VMware ESXi 3.5, if you manually created
and booted the virtual machine, then the virtual machine controller type must be changed to a
BusLogic controller before powering up the virtual machine.

4. (Optional) Add a CD-ROM component to the destination virtual machine. The CD-ROM might be
required to install additional Integrated Components.

5. Power up the migrated virtual machine guest.

After the virtual machine reboots, for agent-less and agent-based hypervisors you must perform the following
steps on the destination virtual machine guest.
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1. Modify the system host name.
2. Perform one of the following:

• For VMware products, install the VMware Tools in the virtual machine.

• For Microsoft Virtual Server 2005, install Virtual Machine Additions in the virtual machine.

• For HP integrated Citrix XenServer, install Xen Guest Tools in the virtual machine.

• For Hyper-V, install Integration Tools in the virtual machine.

3. Check the network connections and re-establish network connectivity. If an IP address conflict occurs
when setting the static IP address, see http://support.microsoft.com/kb/269155/ for more information.

4. View the Windows event log on the destination server and disable any services or drivers that might
have failed.

5. If applicable, then reassign drive letters of dynamic disk partitions using the disk manager to correspond
with the original state. The virtual machine guest automatically detects new hardware and installs the
required drivers.

6. When prompted to reboot, click Yes to restart the virtual machine guest.
The mouse and keyboard might not be immediately active on the migrated virtual machine guest. Wait
until all required drivers are automatically installed by the guest operating system, and reboot the
migrated virtual machine guest when prompted.

7. To activate a graphical boot process, remove the /bootlog and /sos options from the boot.ini file.
These options are automatically inserted during the migration process so that the boot process is logged
in detail for onscreen analysis. The active boot entry displayed during boot is highlighted and the
original boot.ini entry appears as HP SMP Preserved: [name], where [name] is the operating
system.
Additionally, to retain the original boot parameters, copy all valid flags from the original entry and
consider other appropriate boot flags as applicable, such as adding the /3GB flag only if the destination
virtual machine is configured with sufficient RAM.
Then delete the original (preserved) entry, which has been struck through in the following example.

[boot loader]

default=multi(0)disk(0)rdisk(0)partition(1)\WINDOWS

timeout=30

[operating systems]

multi(0)disk(0)rdisk(0)partition(1)\WINDOWS=”Windows Server 2003, Enterprise” /sos /bootlog
/noexecute=optout /fastdetect

multi(0)disk(0)rdisk(0)partition(1)\WINDOWS=”HP SMP Preserved: Windows Server 2003, Enterprise”
/userva=3030 /3gb /noexecute=optout /fastdetect

Virtual-to-virtual (V2V) migrations
A virtual-to-virtual (V2V) migration enables migration of a Windows virtual machine guest between
virtualization layers.

Preparing for a V2V migration
The following sections list prerequisites for a V2V migration.
If you use a firewall, see the Configuring SMP with a firewall section in this guide.
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Source physical machine prerequisites

CAUTION: If the SMP application station shuts down or fails during any migration, then the migration
being performed fails. Availability of application station during complete migration cycle is required for
successful migration.

• Because the SMP application does not migrate virtual machine guests with the following disk types,
verify that these disk types do not exist on the source virtual machine.
The following table details the prerequisites for the source virtual machine.
Table 5-2 Unsupported disk types

Disk typeVirtualization technology

Linked disk
Microsoft Virtual Server 2005

Differencing disk

Append disk

VMware ESX Undoable disk

Nonpersistent disk

Physical (RAW) disk
VMware ESX

VMware Server

• A valid network connection must exist between the source and destination server.

• The source server must contain an active boot partition to be migrated.

• To prevent interrupting the migration process, complete any pending reboots and software installations
on the source machine before initiating a migration.

• Temporarily disable any antivirus software autoscans on the source machine to prevent interrupting the
migration process. Re-enable the antivirus software after the migration.

• Verify that the disks are not corrupted by running CHKDSK and disk defragmenter on the source physical
machine before initiating a V2P migration.
Verify that all hard drives on the source physical machine are correctly initialized (disk signature written).
If Windows 2000 or Windows Server 2003 is installed, then verify initialization by selecting Computer
Management→ Disk Management. Verify that the latest hard drive configuration is saved.

• Verify that all partitions on the source physical machine have a valid file system and are in a healthy
state.

• Disable all applications and background services on the source machine. After the migrated machine
has synchronized with the new hardware and is assigned a unique network identity, appropriate
applications can be manually re-enabled and configured for the new environment.

• Temporarily disable HP Management Agents on the source physical machine.

• Verify that a Windows NT boot loader (NTLDR) is installed.

• During migration, the SMP Agent initiates an operating system reboot on the source physical machine.
Verify that the operating system is on the first boot order. If not, then manually change the boot order
by editing the [system drive]\boot.ini file or by using the bootcfg.exe tool. The SMP application
supports migration of source physical machines that have operating systems installed on the primary
drive (Hard Disk0) and the primary drive loaded first in the boot order.

• Record the drive letter or mount point to disk-partition mapping for dynamic disk partitions before
performing the migration. Any simple (non-extended) dynamic disk partitions are converted to basic
disk partitions. The mapped drive letters might have to be manually reassigned after migration.

SMP application station prerequisites

• Verify that Microsoft iSCSI Initiator 2.06, 2.07, or 2.08, which is required for primary mass storage
driver injection, is installed and running on the SMP application station. If iSCSI Initiator is not installed,

Virtual-to-virtual (V2V) migrations 81



then download and install it from http://www.microsoft.com. Other versions of the initiator, including
later versions, cannot be used with this version of SMP.

• Valid migrated previous P2P licenses or SMP X2P or X2X license keys are required on the application
station. Verify that adequate licenses exist by selecting the License tab in the SMP application station.

• Verify that no virtualization software is installed on the SMP application station.

• To prevent interrupting the migration process, temporarily disable any antivirus software autoscans on
the SMP application station. Re-enable the antivirus software after the migration.

• Disable all the Windows network drive mappings to the source physical machine in the SMP application
station.

• Verify that the SMP application station Windows operating systems version is greater than or equal to
the source physical machine Windows operating system version.

• Verify that the SMP application station Windows operating system is configured for NTFS.

Destination virtual machine host or virtual machine prerequisites
The following prerequisites are for target virtual machine hosts in a P2V migration:

• If the virtual machine host is agent-based, the SMP VM Hosts Agent must be deployed and running on
the virtual machine host before you start the migration.

• If the virtual machine host is agent-less, you can select one of the following:

Let SMP create the virtual machine automatically, and then boot it using the SMP VM Boot CD for
virtual machines.

•

• Create the virtual machine manually, and then boot the virtual machine manually using the SMP
VM Boot CD for virtual machines.

• Verify that the destination virtual machine host has sufficient system resources, including processor,
memory, and disk space to host the migrated virtual machine guest.

• Temporarily disable any antivirus software autoscans on the destination virtual machine host to prevent
interrupting the migration process. Re-enable the antivirus software after the migration.

Performing a V2V migration

CAUTION: If the SMP application station shuts down or fails during any migration, then the migration
being performed fails. Availability of application station during complete migration cycle is required for
successful migration.

To start the V2V Migration Wizard:
1. If you are performing a migration from a stand-alone SMP application station:

• From the desktop, access the SMP Migration Wizard by clicking the SMP application icon.

• From the Overview page, click the Migration Wizard tab.
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• Choose the Windows migration type.

• Click Virtual to Virtual Migration (V2V), and then click Next.

2. If you are performing a migration from HP SIM CMS, choose one of the following options:

• To launch SMP using the HP SIM menu, select Deploy→SMP Migration Tools→ Virtual to Virtual
(V2V), select Windows, and then follow the instructions to launch SMP Migration Tools.

• To launch SMP using Quick Launch, select the proper source server or virtual machine in HP SIM,
scroll over Quick Launch, and then select Virtual to Virtual (V2V).

3. IMPORTANT: When you access the Migration Wizard tab and no license key is available, you are
prompted to add a license key. For more information about licensing, see Licensing SMP.
For additional information, or to purchase licenses, see http://www.hp.com/go/migrate.

NOTE: If you are migrating a server with an older version of the SMP Application Station software
installed, stop the SMP services before installing the SMP Source Agent.

1. Enter the source Server Name or four-part IP address.
2. Select whether SMP must deploy SMP Source Agent on the source server. If you select this option,

you must provide the source server administrative credentials.
3. Click Next.
4. To install SMP Source Agent on the source server, select the Deploy SMP Source Agent checkbox,

enter the User name and Password, and then click Next.
5. If SMP Source Agent is already running on the specified source server, make sure the Deploy SMP

Source Agent checkbox is cleared, and then click Next. The wizard verifies if SMP Source Agent
is already running on the specified source server.

NOTE: Source agents cannot be deployed to Windows 2008 servers using the Deploy Agent
tab on the application station wizard. You must either manually copy the hpsmpagent.exe from
the <installation dir>\Agents\SMP folder to the source server or connect the SMP installation
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CD to the source server, and then install the SMP Source Agent by clicking Install SMP Source
Agent in the auto run window of the SMP application.

4. Select the volumes to be migrated. Volumes marked as active are selected by default. You cannot migrate
or select unsupported file systems.
The boot partition must be migrated. The boot partition is contained in an active volume. If only one
active volume exists, by default it contains the boot partition and cannot be cleared. If multiple active
volumes exist, ensure that the volume containing the active boot partition (which contains the boot.ini,
NTLDR, and NTDETECT.com files) is migrated to the target boot disk. Additional bootable partitions
might be contained in other active volumes, but the partitions do not need to be migrated. The operating
system must be stored on the boot disk and loaded using NT Boot Loader (NTLDR).
Volumes on dynamic disks are migrated to partitions on basic disks. Volumes that span multiple dynamic
disks (including spanned, striped, mirrored, and RAID 5 volumes) are migrated to a single contiguous
partition. Volumes stored on a common source disk must be stored on a common destination disk. You
can only resize NTFS partitions.
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The Computed Destination Server Disk Requirement section lists the disks required on the destination
server to support migrated volumes. The Size, Minimum Destination Size, and Maximum Destination
Size values in the lower table are updated dynamically as volumes in the upper table are selected or
cleared for migration. A message appears under the table, indicating the number of logical units that
must be created on the destination server. The entry in the Minimum Destination Size column is
estimated, based on reducing eligible volumes to their minimum size during migration. Additional space
might be required to accommodate disk geometry differences.

5. Enter the VM Host Name or four-part VM Host IP Address for the destination virtual machine host.
Select the appropriate destination virtualization layer in the Select Virtualization Layer box.

• Agent-based hypervisors—Enter the destination virtual machine host name or IP address, and then
click Next.

• Agent-less hypervisors—Enter the destination virtual machine host name or IP address, and then
enter the host administrative credentials.

• If the destination virtual machine was booted with the SMP Virtual Boot CD, select
Manual Boot - Manually create VM through VM Host's Infrastructure Client. Enter the
four-part IP address of the destination virtual machine, User name, and Password, and
then click Next.
The Virtual Boot CD can be found at <installation
directory>\webserver\webapps\smpui\smpbootcd-v-3.70.iso.
For more information about manually booting a virtual machine with the SMP Virtual Boot
CD, see Prerequisites for manually creating and booting a destination virtual machine.
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• If the destination virtual machine is not created, select Auto Boot - Automatically have VM
created through SMP migration. Enter the four-part VM Pre-boot IP address, Subnet
Mask, and Gateway (optional) to be assigned to the virtual machine, and then click Next.

• If the virtual machine host has an agent-based operating system, click Next.
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6. By default, this page includes a table that displays all disks present on the destination virtual machine,
with source disk, disk format, size, and destination disk information.
The following screen appears when the manually booted destination is selected for agent-less virtual
machine hosts.

Virtual-to-virtual (V2V) migrations 87



The following screen appears when the automatically booted destination is selected for agent-less virtual
machine hosts.

If you are migrating to an agent-based virtual machine host or migrating to an agent-less virtual machine
host that is automatically booted with the SMP Virtual Boot CD:
1. Enter information in the Guest Display Name, Guest Memory, Guest Storage Location, and

Virtual Switch boxes.
2. Select the storage location (if applicable).

• If you are migrating to an agent-based virtual machine, to browse for guest storage location
information, click Browse. A selection window appears where you can enter the destination
folder information or select a remote folder. Click OK. If the destination virtual machine host
is ESX 3.x, you must create a new folder.

• If migrating to an agent-less virtual machine, select the guest storage location from the list.
Click Next.
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If the destination virtual machine is booted with the SMP Virtual Boot CD, select the destination
disk, and then click Next.

3. Some of the columns and rows from the Assign Disks and Resize NTFS Volumes table include:

• Minimum Destination Size—This column displays the minimum size to which a partition or
disk can be resized for the destination disk.

• Destination Size—This column displays the desired partition resize or disk resize on the
destination disk.

• Migration Overhead—This row displays the additional space that must be reserved on the
destination disk to accommodate disk geometry differences.

• Unallocated—This row displays the available space remaining on the destination disk after
the migration is complete. To proceed to the Next wizard page, the value of Unallocated must
either be 0 (zero) or a positive number.

7. Test the network connections and latency between the source-to-destination server and the
application-station-to-destination server. The results of a 2-second test initially appear.

8. To perform additional tests, select a test time in the Test network connections section, and then click
Test. The following test times are available:

• 2 seconds

• 5 seconds

• 10 seconds

• 30 seconds

• 60 seconds

If the source-to-destination or application-station-to-destination connection cannot be established, the
Next button is disabled. Ensure that ports 51125 and 51126 are open between source and destination
servers.
If the source-to-destination or application-station-to-destination connection is established but the network
test reports a transfer speed below 250 kbps, the Next button is disabled.
If the source-to-destination or application-station-to-destination connection is established and the network
test reports a transfer speed of at least 250 kbps, the Next button is enabled.

CAUTION: If the application-station-to-destination latency is less than 125 milliseconds, continue with
the migration. Latency exceeding 125 milliseconds during driver installation might cause the driver
installation to fail. Before continuing with the migration, verify the proper duplex setting, and then check
the latency again.

9. Click Next.
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10. Select the post-migration tasks, and then click Next.

• Select whether the SMP application must perform disk-error checks on the source server before
migration. By default, the Use CHKDSK to detect and fix errors on all source disks prior to
migration checkbox is selected.

• A reboot or shutdown option is not available for the destination virtual machine for X2V migrations
when the option to manually create and the boot the destination virtual machine is selected in
step 3 of the Migration Wizard. After the migration is completed, manually reboot the destination
virtual machine.
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11. Review and confirm the migration details, and then click Begin Migration.
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When you click Begin Migration, the SMP Agent performs a final network check. If the network check
fails, an error message appears. Fix the network issue, and then to continue the migration process, click
Begin Migration again.

12. Review the migration progress details. To cancel the migration, click Cancel. After the entry in the
Job Status field indicates the migration has been canceled, reboot the source and destination servers.

V2V post-migration tasks
After you complete a V2V migration, perform the following steps:

• Agent-less hypervisor—If you performed a migration to an agent-less hypervisor where you manually
booted the virtual machine using the SMP VM Boot CD, you must disconnect the SMP VM Boot CD,
and then manually reboot the virtual machine.

• Agent-based hypervisor—If you performed a migration to an agent-based hypervisor:
Access the destination virtual machine host remote console and manually shut down the virtual
machine.

1.

2. Perform a network configuration for the migrated virtual machine guest. To do so, access the
destination virtual machine host remote console to configure the network connections for the
migrated virtual machine guest.

3. For Windows 2000 Server migrations to HP integrated VMware ESXi 3.5, if you manually created
and booted the virtual machine, then the virtual machine controller type must be changed to a
BusLogic controller before powering up the virtual machine.

4. (Optional) Add a CD-ROM component to the destination virtual machine. The CD-ROM might be
required to install additional Integrated Components.

5. Power up the migrated virtual machine guest.

92 Using SMP for server migration



[boot loader]

default=multi(0)disk(0)rdisk(0)partition(1)\WINDOWS

timeout=30

[operating systems]

multi(0)disk(0)rdisk(0)partition(1)\WINDOWS=”Windows Server 2003, Enterprise” /sos /bootlog
/noexecute=optout /fastdetect

multi(0)disk(0)rdisk(0)partition(1)\WINDOWS=”HP SMP Preserved: Windows Server 2003, Enterprise”
/userva=3030 /3gb /noexecute=optout /fastdetect

Virtual-to-ProLiant (V2P) migrations
A virtual-to-ProLiant (V2P) migration enables migration of a virtual machine guest to a physical ProLiant
server.

Preparing for a V2P migration
The following sections list prerequisites for a V2P migration.
If you use a firewall, see the Configuring SMP with a firewall section in this guide.

Source physical machine prerequisites

CAUTION: If the SMP application station shuts down or fails during any migration, then the migration
being performed fails. Availability of application station during complete migration cycle is required for
successful migration.

• Because the SMP application does not migrate virtual machine guests with the following disk types,
verify that these disk types do not exist on the source virtual machine.
The following table details the prerequisites for the source virtual machine.
Table 5-3 Unsupported disk types

Disk typeVirtualization technology

Linked disk
Microsoft Virtual Server 2005

Differencing disk

Append disk

VMware ESX Undoable disk

Nonpersistent disk

Physical (RAW) disk
VMware ESX

VMware Server

• A valid network connection must exist between the source and destination server.

• The source server must contain an active boot partition to be migrated.

• To prevent interrupting the migration process, complete any pending reboots and software installations
on the source machine before initiating a migration.

• Temporarily disable any antivirus software autoscans on the source machine to prevent interrupting the
migration process. Re-enable the antivirus software after the migration.

• Verify that the disks are not corrupted by running CHKDSK and disk defragmenter on the source physical
machine before initiating a V2P migration.
Verify that all hard drives on the source physical machine are correctly initialized (disk signature written).
If Windows 2000 or Windows Server 2003 is installed, then verify initialization by selecting Computer
Management→ Disk Management. Verify that the latest hard drive configuration is saved.

• Verify that all partitions on the source physical machine have a valid file system and are in a healthy
state.
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• Disable all applications and background services on the source machine. After the migrated machine
has synchronized with the new hardware and is assigned a unique network identity, appropriate
applications can be manually re-enabled and configured for the new environment.

• Temporarily disable HP Management Agents on the source physical machine.

• Verify that a Windows NT boot loader (NTLDR) is installed.

• During migration, the SMP Agent initiates an operating system reboot on the source physical machine.
Verify that the operating system is on the first boot order. If not, then manually change the boot order
by editing the [system drive]\boot.ini file or by using the bootcfg.exe tool. The SMP application
supports migration of source physical machines that have operating systems installed on the primary
drive (Hard Disk0) and the primary drive loaded first in the boot order.

• Record the drive letter or mount point to disk-partition mapping for dynamic disk partitions before
performing the migration. Any simple (non-extended) dynamic disk partitions are converted to basic
disk partitions. The mapped drive letters might have to be manually reassigned after migration.

SMP application station prerequisites

• Verify that Microsoft iSCSI Initiator 2.06, 2.07, or 2.08, which is required for primary mass storage
driver injection, is installed and running on the SMP application station. If iSCSI Initiator is not installed,
then download and install it from http://www.microsoft.com. Other versions of the initiator, including
later versions, cannot be used with this version of SMP.

• Valid migrated previous P2P licenses or SMP X2P or X2X license keys are required on the application
station. Verify that adequate licenses exist by selecting the License tab in the SMP application station.

• Verify that no virtualization software is installed on the SMP application station.

• To prevent interrupting the migration process, temporarily disable any antivirus software autoscans on
the SMP application station. Re-enable the antivirus software after the migration.

• Disable all the Windows network drive mappings to the source physical machine in the SMP application
station.

• Verify that the SMP application station Windows operating systems version is greater than or equal to
the source physical machine Windows operating system version.

• Verify that the SMP application station Windows operating system is configured for NTFS.

Destination physical machine prerequisites

• The primary storage controller must be configured with drives attached.

• The destination server must be booted to SMP Boot CD and running SMP Agent.

Performing a V2P migration

CAUTION: If the SMP application station shuts down or fails during any migration, then the migration
being performed fails. Availability of application station during complete migration cycle is required for
successful migration.

To start the V2P Migration Wizard:
1. If you are performing a migration from a stand-alone SMP application station:

a. From the desktop, access the SMP Migration Wizard by clicking the SMP application icon.
b. From the Overview page, click the Migration Wizard tab.

94 Using SMP for server migration

http://www.microsoft.com


c. Choose the Windows migration type.
d. Click Virtual to ProLiant Migration (V2P), and then click Next.

2. If you are performing a migration from HP SIM CMS, choose one of the following options:

• To launch SMP using the HP SIM menu, select Deploy→SMP Migration Tools→ Virtual to
ProLiant (V2P), select Windows, and then follow the instructions to launch SMP Migration Tools.

• To launch SMP using Quick Launch, select the proper source server or virtual machine in HP SIM,
scroll over Quick Launch, and then select Virtual to ProLiant (V2P).

3. IMPORTANT: When you access the Migration Wizard tab and no license key is available, you are
prompted to add a license key. For more information about licensing, see Licensing SMP.
For additional information, or to purchase licenses, see http://www.hp.com/go/migrate.

NOTE: If you are migrating a server with an older version of the SMP Application Station software
installed, stop the SMP services before installing the SMP Source Agent.

1. Enter the source Server Name or four-part IP address.
2. Select whether SMP must deploy SMP Source Agent on the source server. If you select this option,

you must provide the source server administrative credentials.
3. Click Next.
4. To install SMP Source Agent on the source server, select the Deploy SMP Source Agent checkbox,

enter the User name and Password, and then click Next.
5. If SMP Source Agent is already running on the specified source server, make sure the Deploy SMP

Source Agent checkbox is cleared, and then click Next. The wizard verifies if SMP Source Agent
is already running on the specified source server.

NOTE: Source agents cannot be deployed to Windows 2008 servers using the Deploy Agent
tab on the application station wizard. You must either manually copy the hpsmpagent.exe from
the <installation dir>\Agents\SMP folder to the source server or connect the SMP installation
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CD to the source server, and then install the SMP Source Agent by clicking Install SMP Source
Agent in the auto run window of the SMP application.

4. Select the volumes to be migrated. Volumes marked as active are selected by default. You cannot migrate
or select unsupported file systems.
The boot partition must be migrated. The boot partition is contained in an active volume. If only one
active volume exists, by default it contains the boot partition and cannot be cleared. If multiple active
volumes exist, ensure that the volume containing the active boot partition (which contains the boot.ini,
NTLDR, and NTDETECT.com files) is migrated to the target boot disk. Additional bootable partitions
might be contained in other active volumes, but the partitions do not need to be migrated. The operating
system must be stored on the boot disk and loaded using NT Boot Loader (NTLDR).
Volumes on dynamic disks are migrated to partitions on basic disks. Volumes that span multiple dynamic
disks (including spanned, striped, mirrored, and RAID 5 volumes) are migrated to a single contiguous
partition. Volumes stored on a common source disk must be stored on a common destination disk. You
can only resize NTFS partitions.
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The Computed Destination Server Disk Requirement section lists the disks required on the destination
server to support migrated volumes. The Size, Minimum Destination Size, and Maximum Destination
Size values in the lower table are updated dynamically as volumes in the upper table are selected or
cleared for migration. A message appears under the table, indicating the number of logical units that
must be created on the destination server. The entry in the Minimum Destination Size column is
estimated, based on reducing eligible volumes to their minimum size during migration. Additional space
might be required to accommodate disk geometry differences.

5. Manual - Boot destination server myself—If the destination server is booted to the SMP Boot CD
and the destination agent is launched, select this option.
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6. Auto Boot - Let SMP boot the destination server—If the destination server is not booted to the SMP
Boot CD and the destination agent is not launched, select this option.

7. The Next and Previous buttons are disabled during the reboot. To view the booting process of the
destination server, click Launch iLO, and then open the remote console.
To cancel the boot process and power down the destination server, click Cancel Booting.

8. Test the network connections and latency between the source-to-destination server and the
application-station-to-destination server. The results of a 2-second test initially appear.

9. To perform additional tests, select a test time in the Test network connections section, and then click
Test. The following test times are available:

• 2 seconds

• 5 seconds

• 10 seconds

• 30 seconds

• 60 seconds

If the source-to-destination or application-station-to-destination connection cannot be established, the
Next button is disabled. Ensure that ports 51125 and 51126 are open between source and destination
servers.
If the source-to-destination or application-station-to-destination connection is established but the network
test reports a transfer speed below 250 kbps, the Next button is disabled.
If the source-to-destination or application-station-to-destination connection is established and the network
test reports a transfer speed of at least 250 kbps, the Next button is enabled.

CAUTION: If the application-station-to-destination latency is less than 125 milliseconds, continue with
the migration. Latency exceeding 125 milliseconds during driver installation might cause the driver
installation to fail. Before continuing with the migration, verify the proper duplex setting, and then check
the latency again.

10. Click Next.
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11. Map source disks to destination disks. Ensure that migrated volumes fit on their mapped destination
disks. Select the size of the migrated volumes on the destination server.
The boot partition must be migrated to the first volume of the boot controller. If one active volume is
migrated and the boot controller on the destination server can be identified, the boot partition is migrated
to the first volume of the boot controller. If more than one active volume is migrated or the boot controller
cannot be identified, verify that the boot partition is migrated to the first volume of the boot controller.
Migrated volumes are converted to partitions on basic disks. Boot partitions that span multiple dynamic
disks on the source server are migrated to a single contiguous partition on a basic disk. Volumes stored
on a common source disk must also be stored on a common destination disk. Click Next.
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Some of the columns and rows from the Assign Disks and Resize NTFS Volumes table include:

• Minimum Destination Size—This column displays the minimum size that a partition or disk can be
resized to for the destination disk.

• Destination Size—This column displays the partition or disk resize on the destination disk.

• Migration Overhead—This row displays the additional space that must be reserved on the
destination disk to accommodate disk geometry differences.

• Unallocated—This row displays available space remaining on the destination disk after the migration
is complete. The value of Unallocated should be zero or a positive number to proceed to the Next
wizard page.

• Disk 0, Disk 1, Disk2, and so on—For each row, the value in the Minimum Destination Size and
Destination Size columns represents the sum of partition sizes and migration overhead space for
the disk.

12. Choose from the following options:

• Select whether SMP must perform disk-error checks on the source server before migration. By
default, the Use CHKDSK to detect and fix errors on all source disks prior to migration
checkbox is selected.

• Select the reboot action that the destination server must perform by choosing one of the following
options:

• The destination server must be powered off after migration is complete.

• The destination server must be rebooted after migration is complete.
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• If the destination server is selected to reboot upon completion, additional configuration options
are available. If PSP executables are available on the application station and selected, the network
settings on the destination can be configured. For information on how to upload PSP executables,
see the Upload Drivers section.

• Select a PSP to install on the destination server and configure a static IP for each destination NIC
as needed.

13. Click Next.
14. Review and confirm the migration details, and then click Begin Migration.
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When you click Begin Migration, the SMP Agent performs a final network check. If the network check
fails, an error message appears. Fix the network issue, and then to continue the migration process, click
Begin Migration again.

15. Review the migration progress details. To cancel the migration, click Cancel. After the entry in the
Job Status field indicates the migration has been canceled, reboot the source and destination servers.

16. After the migration is complete, to perform additional migrations, click Begin New Migration. The first
screen of the Migration Wizard appears.
Additional migrations can be set up at the same time the current migration is performed.

V2P post-migration tasks
After you complete a V2P migration, perform the following steps:
1. Remove the SMP Boot CD from the CD drive of the physical machine, and then reboot the system.
2. At the boot options menu, do not change the default selection, HP SIM WIN Conversion ProLiant

Windows.
3. At each of the Welcome to the Found New Hardware wizard screens, click Cancel.
4. When prompted to reboot the system at the System Settings Change window, click No.
5. Install the latest HP ProLiant Support Pack, which includes ProLiant optimized drivers, utilities, and

management agents.
To successfully install the ProLiant Support Pack, SNMP service must be installed. To install SNMP service,
see your operating system documentation.

6. Check the network connections and reestablish NIC teaming, if necessary.
7. View the Windows event log on the destination server and disable any services or drivers that have

failed.
8. To activate a graphical boot process, remove the /bootlog and /sos options from the boot.ini file.

These options are automatically inserted during the migration process so that the boot process is logged
in detail for onscreen analysis. The active boot entry displayed during boot is highlighted and the
original boot.ini entry appears as HP SMP Preserved: [name], where [name] is the operating
system.
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Additionally, to retain the original boot parameters, copy all valid flags from the original entry and
consider other appropriate boot flags as applicable, such as adding the /3GB flag only if the destination
physical machine is configured with sufficient RAM.
Then delete the original (preserved) entry, shown as struck through in the following example.

[boot loader]

default=multi(0)disk(0)rdisk(0)partition(1)\WINDOWS

timeout=30

[operating systems]

multi(0)disk(0)rdisk(0)partition(1)\WINDOWS=”Windows Server 2003, Enterprise” /sos /bootlog
/noexecute=optout /fastdetect

multi(0)disk(0)rdisk(0)partition(1)\WINDOWS=”HP SMP Preserved: Windows Server 2003, Enterprise”
/userva=3030 /3gb /noexecute=optout /fastdetect

9. Install the ProLiant Support Pack either from the SmartStart CD included with your server or by accessing
http://h18000.www1.hp.com/products/servers/management/psp/index.html and clicking Download.

SAN migrations

IMPORTANT: SAN migrations are not supported for Linux migrations.

SMP supports P2P and V2P migrations to servers with Fibre Channel SAN connectivity. To verify that your
Fibre Channel HBA is supported, see the HP Insight Server Migration software for ProLiant Support Matrix.
The steps for performing a P2P or a V2P migration to a server with Fibre Channel SAN connectivity are the
same as performing a local disk migration described in the Performing a P2P migration and Performing a
V2P migration sections, with the following additional preparatory steps before a migration:
1. You must manually set up the SAN environment. This involves creating logical units on the storage,

configuring SAN switches, and configuring the Host Bus Adapter (HBA) BIOS on the destination server.

• Creation of logical units. This requirement depends on the type of storage being used. If a Modular
Smart Array (MSA) is used for storage, then the HP Array configuration utility can be used to create
logical units. The HP Array configuration utility can be run from the SMP Boot CD after it is booted
up on the destination server.
If the storage being used is an Enterprise Virtual Array (EVA), then the management software
specific to the storage must be used. For example, if you have an HP Command View EVA that
can be used for configuring HP StorageWorks 4100/6100/8100 EVAs, you must verify that the
logical units have been presented to the HBA of the destination server.

• Configuration of SAN switches. Intermediate SAN switches used between the destination server
and the storage must be configured for appropriate zoning to ensure proper visibility between the
destination server and the storage array.

• Configuration of the HBA BIOS. Verify that the relevant HBA port is the primary boot controller in
the system BIOS. There are other commonly used configuration settings required in the BIOS of
the HBA. The HBA configuration mechanism varies between HBAs. The HBA BIOS can be accessed
while booting up the system.
Ensure that the HBA BIOS is enabled, that the logical units that were created on the SAN storage
in an earlier step are visible from the HBA BIOS, and that the logical unit to which you plan to
migrate the boot partition on the source server is set as the boot LUN.

2. After setting up the SAN environment, boot the destination server using the Boot CD.
3. Run the Migration Wizard.
4. Follow the relevant migration steps in the Performing a P2P migration and Performing a V2P migration

sections.
5. In step 5 (Specify destination disks) of the Migration Wizard, verify that you have selected the boot

LUN that you configured in the HBA BIOS of the destination server when you migrate the boot partition
on the source machine.
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A SAN migration of Windows 2000 Server or Advanced Server (with SP4) to a destination server with the
Emulex LPe1105-HP 4Gb FC HBA might cause a blue screen on the destination server. To resolve this issue:
1. In step 6 of the Migration Wizard, do not select Perform post-migration steps after successful

migration.
2. Proceed with the migration.
3. After a successful migration, manually install the ProLiant Support Pack on the destination server. Do not

restart the server immediately.
4. The driver for the Emulex HBA must be updated:

a. Download the latest Windows 2000 Boot from SAN HBA driver (version 5.30a2 or later) from
HP Support for the Emulex LPe1105-HP 4Gb FC HBA.

b. Access the Windows Device manager.
c. Expand the SCSI and RAID controllers group.
d. Right click the device corresponding to the Emulex HBA.
e. Click Properties.
f. Access the Driver tab.
g. Click Update driver. Proceed through the steps and point to oemsetup.inf at the location where

you have placed the downloaded Boot from SAN HBA driver.
5. Repeat step 4 for all Emulex HBA devices in the Windows device manager. After the driver update,

restart the destination server.

NOTE: To migrate Windows 2003 to a SAN-connected destination server, you must first install Service
Pack 1, Service Pack 2, and the updated Storport storage driver (see http://support.microsoft.com/kb/
932755) on the source.
You can perform a migration to a destination server with some source disks migrated to local disks on the
destination and some source disks migrated to SAN disks presented to the destination.
A local disk cannot be migrated to a SAN disk on the same server. In other words, a DAS-to-SAN migration
cannot be run on the same server. For example, you cannot migrate an SAS disk on a server to a SAN disk
on the same server. The migration must be a Server A to Server B migration, where A and B are distinct
servers.

SMP application integration to HP SIM
SMP can be accessed through HP SIM, but HP SIM is not required.

HP SIM integration
When SMP is launched from HP SIM, SMP can leverage the HP SIM discovered host list. SMP can list all
appropriate hosts discovered in HP SIM for each step requiring host IP information.
In steps 1 and 3 for each Migration Wizard and the Deploy Agent page, a Show Host List button appears.
To find a server that is discovered in HP SIM, click Show Host List. It is not required that a server from the
Show Host List be selected. The server can be selected also by entering the IP address or server name.
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An option also exists to have the HP SIM-detected hosts always display with no additional steps required.
By default, to have the appropriate hosts always listed on each necessary step of the Migration Wizard:
1. Launch SMP from HP SIM. Select Deploy→SMP Migration Tools→Type of Migration, and then select

a migration option.
You can also select a source virtual machine or source server, and then select a migration option using
Quick Launch.

2. When SMP opens in separate browser, click the Migration Wizard tab.
3. If on step 1 of a migration, click Previous. Ensure the Select the type of migration page is open.
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4. Click the Display servers Discovered in SIM checkbox.
If HP SIM has a large number of systems discovered, then it might take additional time to load each
Migration Wizard step requiring host list.
The systems detected in HP SIM are filtered in the Show Host List to display the proper system type
for each action.

Table 5-4 SMP Steps and HP SIM system filters applied

HP SIM system filter appliedSMP step

HP SIM-discovered servers with Windows operating systemLaunch Windows VM Host Agent

HP SIM-discovered servers with Windows operating systemLaunch SMP Source Agent

HP SIM-discovered servers with Windows operating systemP2X step 1 of Windows Migration Wizard

HP SIM-discovered servers with Linux operating systemP2X step 1 of Linux Migration Wizard

All HP SIM-discovered servers with Windows operating systemV2X step 1 of Migration Wizard

HP SIM-discovered servers with Windows operating systemX2P step 3 of Migration Wizard

All HP SIM-discovered serversX2V step 3 of Migration Wizard

NOTE: Only HP ProLiant servers discovered and identified with an IP address in HP SIM are shown.

Launching SMP migration through HP SIM
To launch an SMP migration from HP SIM, perform the following tasks:
1. In HP SIM, select the source server or source virtual machine.
2. From the main wizard, select Deploy→SMP Migration Tools, and then select the appropriate migration

option.
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3. HP SIM verifies the source server or source virtual machine.

• If the selected server or virtual machine fails to satisfy the criteria to launch SMP migration, then
the HP SIM task wizard appears, the Next button is disabled, and the migration cannot proceed.
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• If the selected server or virtual machine meets the criteria, then the SMP application opens in a
new browser with the IP address of the selected host added in step 1 of the SMP application
Migration Wizard.
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4. If a different host needs to be selected, then click Show Host List. All selected hosts discovered in
HP SIM are displayed. If not, then follow the necessary steps to continue to step 2 and 3 of the Migration
Wizard.

5. The Show Host List option also appears in step 3 of the Migration Wizard. The proper IP address of
the destination virtual machine host or physical server can be added, or a server from the Show Host
List can be selected.

NOTE: All the links added to the HP SIM console during installation of the SMP application are removed
if the application is uninstalled from the machine.

Quick Launch details
To launch an SMP migration from HP SIM using the Quick Launch option, perform the following tasks:
1. In HP SIM, select the source server or source virtual machine.
2. You can access the Quick Launch button using one of the following methods:

• From the All Systems page in the HP SIM console, click Quick Launch. Quick Launch displays
the available operations with the selected source virtual machine or source server.

• From All Systems page in the HP SIM console, select a source server, and then scroll over
Quick Launch. Quick Launch displays the available operations with the selected source virtual
machine or source server.
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3. HP SIM verifies the source server or source virtual machine.

• If the selected server or virtual machine fails to satisfy the criteria to launch SMP migration, then
the Quick Launch list does not display the unsupported migration options.

• If the selected server or virtual machine meets the criteria, then the SMP application opens in a
new browser with the IP address of the selected host added in step 1 of the SMP application
Migration Wizard.

Performing post-migration steps for Windows 2000, Windows 2003, and
Windows 2008

This section only applies if either of the following conditions exist:

• The PSP option was not selected during the migration

• The PSP is manually added after migration

After performing a migration, you must install PSP. Depending on your operating system, perform the Windows
2000 post-migration steps or the Windows 2003 post-migration steps in the following sections.

Windows 2000 post-migration steps
To install PSP with Windows 2000:
1. Insert the SmartStart CD in the local CD drive, or use virtual media. The HP SmartStart CD home page

appears.
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2. Click the Software tab, and then click Custom installation of the PSP for Windows 2000.

3. PSP scans for available bundles to install. After the scan is complete, scroll down, and then click Install.
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4. To ensure that the drivers are installed properly after a P2P migration, select the Allow components
to overwrite newer or up-to-date versions checkbox.

5. To begin the installation, click Next.
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Windows 2003 and Windows 2008 post-migration steps
To install PSP with Windows 2003 and Windows 2008:
1. Insert the SmartStart CD in the local CD drive, or use virtual media. The HP SmartStart CD home page

appears.

2. Select the Software tab, and then click Custom installation of the PSP for Windows 2003 and
Windows 2003x64.
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The HP SmartStart Update Manager begins.

3. To install the PSP on the local host, select Local Host, and then click Next.
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4. The HP SmartStart Update Manager automatically checks for installed items. After the search is completed,
the Select Bundle Filter screen appears.
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5. To ensure that the drivers are installed properly after a P2P migration, in the Set Options for Bundle
Filter section, select the FORCE ALL BUNDLE UPDATES checkbox. To continue, click OK. The
Select items to be installed screen appears.

6. To start the installation, click Install.
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6 Viewing migration logs
Viewing migration logs

The View Status/Logs tab has the following sections:

• View Currently Running Migration(s)—This section displays the status of the running jobs. It also
has links to the source, target, and application station log files. If you need to cancel a migration in
process, click Cancel.
You can view job-specific log files on the application station by accessing SMP installation
path\logs. You can also view job-specific log files by clicking the View logs link in the Progress
column on the View Status/Logs tab. Once a job is complete, its link no longer appears in the View
Status/Logs tab, but the job-specific log files are still be available in the SMP installation
path\logs directory.
Table 6-1 Job-specific log files and job names

Job nameLog files createdMigration typeMigration step

smpDeployAgentApplication stationX2XSource preparation

smpVMCreateAndBootApplication stationX2VDestination preparation

smpILOBootApplication stationX2PDestination preparation

smpMigrationApplication station, source server, destination serverX2XMigration process

To choose a job-specific log file that corresponds to a message in the View Migration Result Log
tab, note the Job ID and timestamp corresponding to that message and then choose the file
jobName-date_time-jobID[-Source/Target].xml. You can also more easily view the file
from a browser at http://localhost:51127/log4j.jsp?log4j=logfilename.

• Error Details—This section appears when an error log from the View Migration Result Log section
is selected. The Error Details section displays possible reasons for the condition, troubleshooting tips,
and a reference to the applicable troubleshooting section in the HP Insight Server Migration software
for ProLiant User Guide.

• View Migration Result Log—This section displays a log indicating the results of the migrations.

• Log Details—This section appears when an item from the View Migration Result Log section is
selected.
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To view migration logs, scroll through the View Migration Result Log table.
If there are enough logs of performed migrations, you must scroll through the migration logs table. The View
Migration Result Log table includes the following columns:

• Checkbox—Enables you to select migration logs for deletion. You can select multiple logs simultaneously.
Select the logs to be deleted, and then click Delete.

• Status—Displays icons that show if a migration was successful, failed, or has information.

• Time—Lists the date and time of the migration step.

• Server—Indicates where the migration step was performed.

• Message—Lists information about the migration step.

• Job ID—Indicates the migration job identification.

To view more information about a specific entry, click the log entry. Additional details appear on the lower
portion of the screen.
You can sort log messages by clicking the titles.
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7 Uploading drivers
The Upload Drivers tab displays the status of iSCSI initiator installed and all PSPs added to the application
station for SMP.

PSPs executables can be uploaded from this console when SMP is launched as a standalone product or
when SMP is launched from HP SIM. Enter the PSP location in the box, or click Browse to find the PSP file
location, and then click Upload.
The PSPs are copied to <installation directory>/psp/ folder. The PSP must not be extracted
before upload. Ensure that the application station has enough disk space before uploading the PSPs to the
application station. During P2P and V2P migrations, PSPs can be selected to be installed after the migrations
have completed.
To display all valid executable files inside the /psp/ folder, refresh the Upload Drivers page.
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8 Troubleshooting
Troubleshooting
Installation

When launching the SMP wizard immediately after installation, the message Unable to
communicate with the SMP service displays on the wizard page

Usually, the service manager shows that SMP service is launched. However, because of DNS lookup or
other network latency, the communication to the service is not established, which causes this error message.
To resolve this issue perform one of the following actions:

• Wait a few minutes until the DNS requests time-out after the installation, and then start the wizard.

• Add the host name of the application station and IP address to the
WINDOWS\system32\drivers\etc\hosts file.

SMP installation displays The SMP cannot be installed on a machine with an empty
or invalid credentials error

1. Verify if the user name has administrative privileges on the system.
2. Provide only the username in the username box and domain information in the domain box.

Blank passwords are not be accepted by the installer because the service fails to register.

3. To reset the password:
1. From the desktop, select Control Panel→User Accounts.
2. Reset the password of the user, and then enter a valid password.

SMP related menus missing after installing HP SIM on SMP
When HP SIM is installed after installing the SMP, SMP menus do not appear in HP SIM. For the menus to
appear on the HP SIM application, you must uninstall and then reinstall SMP again.

SMP-related menus missing
When a user with administrator privileges installs SMP on a system with HP SIM already installed, SMP
related menus might be missing, and the following message appears:
NOTE: Installer has detected System Insight Manager running on this host.
Please provide the Service Account Credentials of a Valid Administrator account
of System Insight Manager Application Only.

The credentials accepted by SMP are used for registering and starting the application. These credentials
should be for a local administrator or domain administrator.
For example, if user 1 installs SMP using administrator privileges, user 1 must be added to an HP SIM account
and given administrator privileges in HP SIM, for the SMP menu to display in HP SIM.
To add user 1 to an HP SIM account:
1. Sign in to HP SIM.
2. Select Options→Security.
3. Select Users and Authorizations.
4. Add User 1 to the New User section of the screen, where all details pertaining to this user are configured.
5. In the Central management server configuration rights section, select full, allowed to modify all

central management server settings, and then click Apply.

Support for older versions of stand-alone P2P application
The installation of stand-alone P2P application (version 1.4 and earlier) on a system which already has SMP
is not supported.
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If you need to downgrade to an older version of the P2P application, you must use the following installation
order:
1. Uninstall the older version of P2P application.
2. Install SMP.

Configuration

Ports required for SMP are not available
This issue occurs if port numbers 51124, 51125, 51126, or 51127 have been locked by another application.
To verify, choose one of the following:

For Microsoft Windows Server™ 2003 systems

1. At the command line prompt, enter the following command: netstat –n –o –a
2. View the Local Addresses column to identify the ports currently in use.
3. Note the process identifier numbers (PIDs) for ports 51124, 51125, 51126, and 51127.
4. Open the Windows Task Manager, and then click the Processes tab.
5. Click View→Select Columns.
6. Select PID (Process Identifier), and then click OK.
7. Locate the PIDs in the PID column that were identified in step 3, and then determine the service that is

currently using the ports needed for SMP.
8. Contact your system administrator to release these ports.

For Windows 2000 Server systems
1. To obtain the PIDs for ports 51124, 51125, 51126, and 51127, download TCPView from

http://www.sysinternals.com/Utilities/TcpView.html , and then run the application.
2. Open the Windows Task Manager, and then click the Processes tab.
3. Click View→Select Columns.
4. Select PID (Process Identifier), and then click OK.
5. Locate the PIDs in the PID column that were identified in step 1, and then determine the service that is

currently using the ports needed for SMP.
6. To release these ports, contact your system administrator. Optionally, you can reboot the server. Several

reboots might be necessary.

Configuring SMP with a firewall
When managing virtual machine hosts behind a firewall, the firewall must be configured to enable Virtual
Machine Management Pack and SMP traffic through the firewall. The following ports are used:

• Communication between browsers and the HP SMP Web Service uses HTTP over port 50000.

• Communication between the SMP Web Service and SMP (both on the SMP application station) uses
SSL over port 51124.

• Communication between the SMP Web Service and integrated Lights Out (iLO) for auto destination
boot uses port 51125.

• Communication between SMP and SMP Agent (on physical servers, virtual machines, and virtual machine
hosts) uses SSL over port 51125.

• Communication between the SMP Agents during migration operations uses SSL over port 51126.

• Communication on the application server for SMP Web Server uses port 51127.

122 Troubleshooting

http://www.sysinternals.com/Utilities/TcpView.html


Verify that necessary ports are open on the application station, source servers (physical or virtual) and
destination servers (physical or virtual machines or virtual machine hosts).

Microsoft DNS Server might not map the host name to DHCP-generated IP addresses
If you use DHCP on the VMware ESX host, the Microsoft DNS server might not map the host name to
DHCP-generated IP addresses. To connect to the server, use the DHCP-generated IP address, or assign a
static IP address for the server.

Source preparation

Corrective action is required before migrating some preinstalled HP Microsoft Windows Server
2003 operating systems

The following message appears when an affected system is detected while launching the source server agent:
ATTENTION: Corrective action is required before this server can be migrated.

Some versions of Windows Server 2003 that are preinstalled by HP cannot be migrated successfully unless
corrective action is performed before attempting the migration.
Affected systems are detected by the source agent during initialization. If the system is affected, instructions
for performing the corrective action are provided.
If you attempt the migration without first performing the corrective action, your destination server becomes
non-bootable and a license is consumed.

NOTE: This agent does not detect whether the corrective action has been performed. Subsequent attempts
to execute this agent indicate that the corrective action is required. The corrective action only has to be
applied once.

To resolve this issue:
1. Cancel the SMP Agent execution.
2. In the command prompt window, change to the root directory of the Windows disk.
3. Run the following command: SFC /SCANNOW. This command might take several minutes. For more

information about this command, see http://support.microsoft.com/kb/310747/en-us.

Corrective action is required for some source servers with HP iLO Management Channel Interface
Drivers

The following message might appear during installation:
ATTENTION: Corrective action is required before this server can be migrated.

Some versions of the HP iLO Management Channel Interface Driver cause issues when Windows 2000
Server performs plug and play for the iLO 2 device on the destination server.
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The Windows 2000 Plug and Play (PnP) process might result in a system bug check if all of these conditions
are met:

• The source server is running Windows 2000 Server or Windows 2000 Advanced Server.

• The source server has the HP iLO Management Channel Interface driver version 1.7.2195.0 or later
installed.

• The destination server has an iLO 2 device installed.

• Remedial action was not performed on the source server (normally performed during execution of the
SMP Agent).

As a precaution, the files used during the PnP process must be removed before performing the migration.
The following files, located by default in the C:\CPQSYSTEM\pnpdrvs directory must be removed:

• cpqci.dll

• cpqcidrv.cat

• cpqcidrv.inf

• cpqcidrv.sys

Removal of these files does not affect iLO operation on the source server.
To delete the files and continue with the agent execution, select the files, and then click OK. To cancel the
execution of the source agent, click Cancel.
The source agent determines if the files in the default location must be removed. Files in non-default locations
are not detected. If the files are not detected and removed from the source server before performing the
migration, the destination server might generate a system bug check during the PnP process for the iLO 2
device.
If the issue causes a system bug check on the destination server, return the server to a normal state by
performing the following steps:
1. Boot the destination server in Windows Safe Mode.
2. Open the Registry Editor.
3. Delete the following key: HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\cpqcidrv
4. Reboot the destination server.

Source server identification fails
If the source server identification fails in step 1 of the Migration Wizard:
1. Verify the identifier entered. If the name is entered for a source server that is in a domain, be sure that

the Fully Qualified Domain Name (FQDN) is entered.
2. Verify that the SMP Agent has been installed on the identified source server. For more information about

running the SMP Agent, see the HP Insight Server Migration software for ProLiant User Guide.
3. Verify that the source server can be reached from the application station. Communication on network

ports 51125 and 51126 must be enabled by any firewall between the application station and the
source server.

4. Verify that the agent status messages do not indicate that the source server is locked to another computer.

Deploy Agent task to Windows fails
Performing a Deploy Agent task to Windows for a virtual machine host or an SMP Source Agent might fails,
causing the following message to appear: Unable to connect to the remote host.
Before performing a deploy agent task, verify the following items:
1. No volumes on that host are mounted from the application station account. If there are volumes mounted

from the application station, then delete them from the command window by entering:
net use /delete *.

2. The destination IP address does not have the ADMIN$ share available.
3. A firewall was enabled on either the local or remote destination that prevented access to the share ports

for network shares.
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4. The destination server is unavailable or has ping (echo ICMP) disabled.
5. The user credentials provided have administrative access.

If the issue persists, manually deploy the agent.

SMP Agent deployment fails
SMP Agent might fail deployment because of the following:

• Incorrect user name or password—Verify that you have provided valid credentials with administrative
rights for the source physical machine for the SMP Agent deployment.

NOTE: SMP application station server is not a valid source physical machine for migrations.

• The ports reserved for SMP Agent (51124 through 51126) might be used by other processes—These
ports are reserved during installation and this issue can usually be resolved with a reboot. If the issue
persists, then other processes using the ports must be identified and disabled.

• Agent might not be installed. For Windows 2008 Source servers, ensure the agent is installed. 64-bit
Windows operating systems are not supported by SMP.

• Ensure that there is sufficient disk space for agent to be copied and installed properly.

• Network on both the source and the SMP station must be properly working.

• The root login must be enabled on the destination ESX 3.x host, and root credentials are used for
deploying agent to the host. To deploy the agent:
1. Edit the /etc/ssh/sshd_config file.
2. Set PermitRootLogin to yes and ensure it is not commented out.
3. Restart the sshd service.

• If you are launching SMP Source Agent to a virtual machine, check the virtual machine console with
virtual machine host management console for any errors.

The agent success and failures are logged onto system drive\hpsmpagent.log file on the source server.

Linux SMP Source Agent deployment fails
The SMP VM host or the SMP Source Agent might fail deployment because the root login must be enabled
on the destination Linux host, and root credentials are used for deploying agent to the host. To deploy the
agent, perform the following steps on the Linux host:
1. Edit the /etc/ssh/sshd_config file.
2. Set PermitRootLogin to yes and set PasswordAuthentication to yes. Verify the entries are

not commented out.
3. Restart the sshd service.
For a Linux SMP Source Agent deployment, verify SELinux is in passive mode.

SMP Source Agent deployment fails remotely from a Windows 2003 Application Station
SMP uses a file share on the source server to deploy the agent from the application station. For the file share
to operate, the following conditions must be met:

• The Server or Workstation service must be started on the source server

• The Server or Workstation service must be started on the application station

• A "Client for Microsoft Networks" client must be added to the network interface properties on the source
server

• A "Client for Microsoft Networks" client must be added to the network interface properties on the
application station
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SMP Source Agent installation takes longer than usual
If the installation of the SMP Source Agent takes longer than usual, then refer to the SMP source server
console or the SMP Source Agent log file for more information. You can find the SMP Source log files at
C:\hpsmpagent.log on the source server.

Destination preparation

Destination server displays a blank screen when SMP Boot CD is used to boot the server
This might happen when the server has more than 64 GB of RAM. To resolve this issue:
1. Power down the server.
2. Reduce the amount of RAM to less than 64 GB.
3. Reboot the server.

Destination server identification fails
If the destination server identification fails in step 3 of the Migration Wizard:
1. Verify that the network adapter on the destination server is configured with a valid IP address, subnet,

and gateway. Also verify the network configuration information reported on the destination server.
2. Verify that the destination server is booted from the SMP Boot CD and ready for migration. For more

information, see the HP Insight Server Migration software for ProLiant User Guide.
3. Verify that the destination server can be reached from the application station and source server.

Communication on network ports 51125 and 51126 must be enabled by any firewall between this
computer and the destination server.

4. Verify that another SMP application is not already communicating with the destination server.

Application station fails to connect to the destination server
After an automatic boot through iLO during a P2P or V2P migration, the application station may fail to
connect to the destination server and the message Could not connect to destination server
agent. appears in the migration wizard. This error can occur if the destination server has multiple NICs
connected to different networks and the IP address is configured to a NIC that is not on the same network
as the application station. To resolve this issue, verify that the destination server and the application station
are on the same network.

IP address configuration fails on a manually booted virtual machine in Hyper-V for a P2V or a V2V
migration

If you have manually created the virtual machine on Hyper-V for a P2V or a V2V migration, booted the
virtual machine manually with the SMP Boot CD for virtual machines, and you are unable to configure an
IP address on the virtual machine, then perform the following:

• Ensure that the virtual machine that you have manually created has a legacy network adapter.

• Ensure that the legacy network adapter on the virtual machine is connected to the correct virtual network
switch on the host.

• Ensure that the Virtual network switch configuration on the Hyper-V host is correct and the virtual switch
is connected to a physical network adapter with external network connectivity.

Kernel Panic when booting a virtual machine to the SMP Virtual Boot CD
To resolve this issue:
1. Power down the virtual machine.
2. Ensure that the virtual machine has at least 600 MB of RAM.
3. Reboot to the SMP Virtual Boot CD.

Manual boot of HP integrated Citrix XenServer fails
When using the SMP Virtual Boot CD, the following error message displays: No network found.
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Possible causes for the error message include:

• Network card is not connected to the network.

• Network to which the card connects to does not have DHCP.

• Network card is not supported by the SMP Boot CD. Make sure you are using a supported server using
the HP Insight Server Migration software for ProLiant Support Matrix.

To resolve this issue make sure the IP address to all NICs in the virtual machine are configured. The NICs in
the Boot CD might not be listed in the same order as the NICs on the virtual machine.

Mouse does not work on a virtual machine booted with the SMP VM Boot CD for virtual machines
Use the Tab and Enter/Return keys on the keyboard to navigate the user interface on the SMP VM Boot
CD for virtual machines.
This issue occurs because virtual machine tools required for the mouse on certain virtualization layers are
not available on the SMP VM Boot CD.

Primary array controller does not have logical drives defined
1. Confirm that your array controller has at least one logical drive defined.
2. You can confirm this by accessing the Configure Destination Server screen and then clicking Launch

Array Configuration Utility or by rebooting to Option ROM Configuration for Arrays (ORCA).

Primary controller configured in the system does not have drives attached
Confirm that your hardware setup is correct and that the correct controller is set to primary in ROM-Based
Setup Utility (RBSU).

Primary controller in system is not supported by this version of SMP

• Verify the primary controller is supported for SMP. For a complete list of supported controllers, see the
HP Insight Server Migration software for ProLiant Support Matrix.

• Verify the latest firmware is installed on the storage controller.

• If the SMP ProLiant Boot CD cannot detect the storage controller, you may need to reconfigure the
storage controller environment variable.
1. Reboot the destination server to Rom-Based Setup Utility (RBSU) by pressing the F9 key during

POST.
2. Select the Boot Controller Order option and verify the proper boot order for the storage controllers.
3. Press Esc to exit RBSU, and then press F10 to confirm the exit and to save your changes.
4. Reboot the destination server using the SMP ProLiant Boot CD.
When the destination server boots up, the SMP ProLiant Boot CD will detect the storage controller.

SMP Boot CD might stop responding when exiting the Array Configuration Utility
When exiting the Array Configuration Utility, the SMP Boot CD might stop responding. If this occurs, to
restart the server, physically restart the server or use the Virtual power option in iLO.

Some storage volumes on the destination server are not available for selection
Some storage volumes configured on the destination server might not be available for selection in Step 5
(Specify Destination Disks and Resize NTFS Partitions) of the Migration Wizard. If expected volumes do not
appear, perform one of the following:

• Verify that the storage controller is supported by SMP. Volumes configured on an unsupported storage
controller cannot be selected for migration. For more information about supported controllers, see the
HP Insight Server Migration software for ProLiant Support Matrix.

• Run the Array Configuration Utility, and verify the status of the volumes on the Smart Array controller
to be sure that the volumes are not in a failed state. Also, verify that all volumes on the controller are
numbered sequentially beginning with logical drive 1, as required by the SMP. If volumes are not
numbered sequentially, clear the configuration and recreate the necessary volumes.
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Static IP address cannot be assigned on the destination server while booting using the Boot CD
Assigning a static IP address on the destination server might result in an error similar to the following:
The IP address xxx.xxx.xxx.xxx you have entered for this network adapter is
already assigned to another adapter.

This might occur if the IP address is assigned to another network adapter on the destination server. To resolve
this issue, assign a different IP address to the network adaptor or reboot the server.

Supported storage controllers display Unknown on the Boot CD
If the supported storage controllers for P2P or V2P migrations are blocked by the SMP Boot CD, the controller
might appear as Unknown.
To correct this issue, reset NVRAM on the destination server by completing the following:
1. Reboot destination server.
2. To enter ROM-Based Setup Utility (RBSU) during reboot, press F9.
3. Open Advanced Options, and then select Restore Settings/Erase Boot Disk or Clear NVRAM.
4. Reboot the system using the SMP Boot CD. The proper storage controller name is detected.

Auto booting destination server using iLO fails
If the destination server does not boot and no error message appears on the application station, then reset
the iLO on the destination server, and reboot again.

SMP might not detect virtual machines on mapped network drives
SMP cannot locate virtual machines stored on mapped network drives if the service does not have access
to the network shares. You must manually migrate these disks after a successful migration.

Deploy Agent task to Windows fails
Performing a Deploy Agent task to Windows for a virtual machine host or an SMP Source Agent might fails,
causing the following message to appear: Unable to connect to the remote host.
Before performing a deploy agent task, verify the following items:
1. No volumes on that host are mounted from the application station account. If there are volumes mounted

from the application station, then delete them from the command window by entering:
net use /delete *.

2. The destination IP address does not have the ADMIN$ share available.
3. A firewall was enabled on either the local or remote destination that prevented access to the share ports

for network shares.
4. The destination server is unavailable or has ping (echo ICMP) disabled.
5. The user credentials provided have administrative access.

If the issue persists, manually deploy the agent.

Windows SMP Agent deployment fails
SMP Agent might fail deployment because of the following:

• Incorrect user name or password—Verify that you have provided valid credentials with administrative
rights for the source physical machine for the SMP Agent deployment.

NOTE: SMP application station server is not a valid source physical machine for migrations.

• The ports reserved for SMP Agent (51124 through 51126) might be used by other processes—These
ports are reserved during installation and this issue can usually be resolved with a reboot. If the issue
persists, then other processes using the ports must be identified and disabled.

• Agent might not be installed. For Windows 2008 Source servers, ensure the agent is installed. 64-bit
Windows operating systems are not supported by SMP.

• Ensure that there is sufficient disk space for agent to be copied and installed properly.
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• Network on both the source and the SMP station must be properly working.

• The root login must be enabled on the destination ESX 3.x host, and root credentials are used for
deploying agent to the host. To deploy the agent:
1. Edit the /etc/ssh/sshd_config file.
2. Set PermitRootLogin to yes and ensure it is not commented out.
3. Restart the sshd service.

• If you are launching SMP Source Agent to a virtual machine, check the virtual machine console with
virtual machine host management console for any errors.

The agent success and failures are logged onto system drive\hpsmpagent.log file on the source server.

Destination server boots from the SMP boot CD on a manual boot
During the migration, when the auto-boot option is chosen to boot the destination server, the application
station boots the destination server from the SMP boot CD by connecting the virtual media to the destination
iLO. When the migration is canceled by closing the migration wizard, the virtual media remains connected
to the destination iLO.
You can view a list of IP addresses where virtual media is still connected to the server in the SMP
installation directory/bin/iLOIP.lst file. To disconnect these virtual media, enter SMP
installation directory/bin/ResetILOVM.cmd -i xxx.xxx.xxx.xxx -u username -p
password where xxx.xxx.xxx.xxx is the iLO IP address.

Migration process

Drivers cannot be installed or injected onto boot disk
This error is reported if SMP fails to install or inject device drivers. In most cases, additional information is
reported on the destination server. Possible causes for this error include:

• The boot partition was not migrated to the boot volume on the destination server. Verify that the boot
partition is selected for migration and placed on the boot volume of the destination server.

• The network connection failed during driver installation.

• The destination server failed or was powered down during driver installation.

• The storage controller where the boot partition was placed is not supported. For a complete list of
supported controllers, see the HP Insight Server Migration software for ProLiant Support Matrix.

• The iSCSI initiator failed to mount the disk. To resolve this issue, reinstall the iSCSI initiator on the
application station.

Large volumes fail with server thread error
Migrating extremely large volumes (larger than 1 TB) can result in a failed migration with the following
message:
Server Migration failed. Error occurred in server thread; nested exception is:
java.lang.OutOfMemoryError.

To resolve this issue, increase the size of the Windows paging file.

For Windows 2003
1. From the Control Panel, double-click System.
2. In the System Properties window, click the Advanced tab.
3. In the Performance section, click Settings.
4. In the Performance Options window, click the Advanced tab.
5. In the Virtual memory section, click Change.
6. In the Drive [Volume Label] column, select the drive that contains the paging file to be changed.
7. Select Custom size, and then enter a new paging file size in the Initial size (MB) box.
8. Click Set.
9. Click OK until all windows are closed.
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For Windows 2000
1. From the Control Panel, double-click System.
2. In the System Properties window, click the Advanced tab.
3. Click Performance Options.
4. In the Virtual Memory section in the Performance Options window, click Change.
5. In the Drive column, select the drive that contains the paging file to be changed.
6. In the Paging file size for selected drive section, enter a new paging file size in the Initial size (MB)

box.
7. Click Set.
8. Click OK until all windows are closed.

Migration fails if certain Update Rollup versions exist
A migration fails if Update Rollup 1 version 1 or 2 is installed on top of Windows 2000 SP4 on the source
machine. To continue with the migration, the current version of the scsiport.sys file on the source machine
must be rolled back to the version present in Windows 2000 SP4.
To roll back the current version:
1. Rename the Scsiport.sys file to Scsiport.sys.old. This file is located in the

%windir%\System32\Drivers folder.
2. Copy the Scsiport.sys file from Windows 2000 SP4 to the %windir%\System32\Drivers folder.

For information about how to extract service pack files, see the Readme for Windows 2000 Service
Pack 4 (ReadMeSP.htm) document at http://www.microsoft.com/windows2000/downloads/
servicepacks/SP4/ReadMeSP.htm.

Migration fails to terminate if source server is shut down
In some network, firewall, or router configuration scenarios, SMP might fail to recognize that the source
server is no longer available during a migration and remain in migration mode.
In this scenario, perform the following procedure:
1. Close SMP.
2. Open the Windows Services Manager, and then restart the SMP application service and the HP SMP

Web Service.

NTFS partitions cannot be resized from a Windows 2008 application station
SMP does not resize NTFS partitions when migrating to an agent-based virtual machine host from a Windows
2008 application station. To resolve this issue, initiate the migration from a Windows 2003 application
station.

NTFS resize error message
The following message might appear during the migration of certain NTFS volumes:
The file system on source disk x, partition y could not be resized during
migration. The NTFS volume information could not be read. Retry the migration
without resizing this volume. Defragmenting the NTFS volume or performing a
"chkdsk /f" prior to the migration may resolve this condition.

The preceding message appears when SMP cannot process the NTFS meta information for this volume, and
the volume cannot be resized during migration.
To resolve this issue, do not resize the volume. Instead, perform a disk defragmentation or run chkdsk /f to
resolve the issue. However, performing a successful defragmentation and disk check, does not guarantee
the ability to resize. In this case, the volume can only be migrated without resizing.

SMP migration fails during the disk cloning phase
The following error message appears on the application station log (hpsmpsvc.log):
com.hp.mx.smp.vmdisk.api.APIException: Not enough space for partition!

This error might if the destination server disk has a Windows Logical Partition configured on it.
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To resolve this issue:
If an existing disk already containing some Windows partitions is used as the destination for migration,
format the disk before using it as a destination disk.

SMP cannot perform V2V migrations on virtual machine guests with certain disk types
SMP does not move, copy, or migrate virtual machine guests with the following disk types.
Table 8-1 Unsupported disk types*

Disk typeVirtualization technology

Linked disk
Microsoft Virtual Server 2005

Differencing disk

Append disk

VMware ESX Undoable disk

Nonpersistent disk

Physical (RAW) disk
VMware ESX

VMware Server

* For V2P and V2V migrations, dynamic disk support is limited to simple and mirrored volumes.

V2P and V2V migration have limited support for dynamic disks. Only mirrored and simple dynamic partitions
are supported. These are migrated as basic partitions on the destination.

Starting a new migration after a current migration is stopped
If a migration is stopped by means other than a cancellation or failure, the application station, source server,
and destination server might not recognize that the migration has stopped. To start a new migration:
1. Restart the SMP Agent on the source and destination servers.
2. On the application station, close the Migration Wizard.
3. Restart the HP SMP application service and the HP SMP Web Service.
4. Reopen the Migration Wizard.

Unrecoverable sector-read errors on the source server hard drive are not supported and fail a
Windows P2P or P2V migration

The following error message might appear if a volume with unrecoverable sector-read errors is migrated:
Server Migration failed. ReadFile failed.

Hard drives automatically take corrective action when they have difficulty reading a sector. These sectors
are marked as “bad sectors” and relocated to one of the sparse sectors in a reserved area of the hard disk.
In these cases, no read error is produced, and the drive continues to function properly. The data is lost and
a read error is propagated to the operating system only if the surface error rate is too high and additional
sparse sectors are not available, or when the sector is completely unreadable from the beginning.
If file system tools are used to detect these failing sectors (for example, chkdsk /p /r), the clusters are marked
as “bad.” However the data cannot usually be recovered. In such cases, the system is not consistent, and
proper migration is not possible.
SMP does not support the migration of volumes with unrecoverable bad sectors.

Source agent fails to launch when source server reboots in SMP Agent Mode
If the SMP Agent fails to launch when the source server reboots in SMP Agent Mode:
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1. To return to the original configuration, reboot the source server to Profile 1 Hardware Profile.
2. Remove SMP Source Agent Mode manually.

a. Right-click My Computer, and then select Properties.
b. Click the Hardware tab, and then select Hardware profiles.
c. Select SMP Source Agent Mode, and then click Delete.

3. Before starting a new migration, verify that all antivirus and firewall software is properly reconfigured
or disabled.

Error during data copy of Linux migration
If an Error during data copy offset=offset srcPos=source sector dstPos=destination
sector amount=number of sectors error occurs in the source or destination log followed by a I/O
Exception, there could be bad blocks on the source or destination disk.
SMP does not support migrations of disks with bad blocks. If the bad block is on the destination disk, change
the destination disk.

Destination server reboots continuously with a blue screen
If your destination server is a BL680c G5 or a BL685c G1 and you choose to automatically install PSP from
the Migration Wizard but the destination server reboots continuously, the issue could be a conflict with the
"HP Storageworks Tape Drivers for Windows" drivers.
To resolve this issue, when Windows boots up, press F8 to go to boot options and select Last known good
configuration. After Windows fully boots up, uninstall the "HP Storageworks Tape Drivers for Windows"
drivers and reboot the server.

SAN-connected destination server displays blue screen
To migrate Windows 2003 to a SAN-connected destination server, you must first install Service Pack 1,
Service Pack 2, and the updated Storport storage driver (see http://support.microsoft.com/kb/932755) on
the source.

Post-migration

A PSP installation after an X2P migration of Windows 2000 to a server with the Emulex
LPe1105-HP 4Gb FC HBA might cause a blue screen on the destination server

A SAN migration of Windows 2000 Server or Advanced Server (with SP4) to a destination server with the
Emulex LPe1105-HP 4Gb FC HBA might cause a blue screen on the destination server. This can happen if
you select automatic installation of PSP during step 6 of the Migration Wizard or if you manually installed
PSP without immediately installing the latest Emulex boot from SAN HBA driver for Windows 2000.
To resolve this issue:
1. Restart the destination server.
2. Press F8 when you see the following message: Please select the operating system to

start.

3. When the Windows Advanced Options menu appears, select Last Known Good Configuration
(your most recent settings that worked), and then press Enter.

4. After Windows boots, install the ProLiant Support Pack on the destination server manually. Do not restart
the server immediately.

5. The driver for the Emulex HBA now needs to be updated.
a. Download the latest Windows 2000 Boot from SAN HBA driver (version 5.30a2 or later) from

HP Support for the Emulex LPe1105-HP 4Gb FC HBA.
b. Access the Windows Device Manager.
c. Expand the SCSI and RAID controllers group.
d. Right-click the device corresponding to the Emulex HBA.
e. Click Properties.
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f. Access the Driver tab, and then click Update driver.
g. Proceed through the steps and point to oemsetup.inf at the location where you have placed

the downloaded Boot from SAN HBA driver.
6. For all Emulex HBA devices seen in the Windows device manager, repeat step 4. After the driver update,

restart the destination server.

Error message appears during P2P installation
The following error message might appear during a PSP installation.

This message does not affect the PSP installation. To continue with the PSP installation, click OK.

Migration does not start after confirmation. The event log continuously displays Operation
Migration waiting for connection to source

When the migration starts, the source server reboots and runs the SMP Agent in exclusive mode during
migration.
Rebooting the source machine might take a few minutes. If this process takes a long time, verify that the
source machine is rebooted with SMP Agent running in exclusive mode. The source machine might be waiting
for user input during the reboot.
If SMP Agent is deployed on an operating system that is not first in the boot order, SMP Agent might fail to
boot to the SMP mode. To resolve this issue, change the boot order by editing (system drive)\boot.ini,
and verify that the operating system on which SMP is deployed is first in the boot order.

AdapterMismatch message appears
When you power up a virtual machine migrated to a VMware host, the following message appears on the
VMware Management console:

This message appears only when the virtual machine is powered up for the first time. To boot up the virtual
machine properly, select No, and then click OK.
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Destination server mouse and keyboard do not work
The mouse and keyboard might not be operational immediately:

• On the destination server after a migration

• On a c-Class server blade after performing a Windows 2000 migration

To detect and activate the mouse and keyboard, reboot the destination server so that PnP correctly detects
and activates the mouse and keyboard.
To resolve this issue, you must to re-run the migration and enable auto installation of PSP with Static IP
configuration, in Step 6 of the P2P or V2P Migration Wizard. After the migration is complete, this issue can
be resolved by deleting the ghost devices as follows:
1. With Remote Desktop using the static IP address provided in Step 6 of the P2P or V2P Migration Wizard,

connect to the destination server.
2. Open a command prompt on the destination server and enter the following:

set devmgr_show_nonpresent_devices=1

devmgr.msc

3. In the device manager select view, and then select Show Hidden Devices.
Look for ghost keyboard and mouse devices with a yellow or red sign.

4. Right click the ghost device, and then select uninstall.
5. Reboot the destination server.

DNS error appears in the destination server after migration of domain controller
This happens when the static IP address is assigned to the NIC, which is not connected to the network on
the destination server. To correct this issue:
1. Reconfigure the NIC connected to the network to accept a static IP address.
2. Assign the same IP address to the NIC that the DNS server has.
3. Restart the server.

Drive letters are not the same in the migrated virtual machine guest after migration
Depending on the operating system, perform the following task:
1. For Windows 2000 or Windows 2003 systems, select Control Panel→Administrative Tools→

Computer Management→Disk Management.
2. Correct the incorrect letter assignment in the migrated virtual machine guest using the disk administrator

or manager.

Drives do not display on the migrated operating system
After a successful migration, some migrated volumes do not appear in Windows Explorer.
Depending on the operating system, perform the following task to assign a driver letter to the volume so it
is visible in Windows Explorer:
1. For Windows 2000 or Windows 2003 systems—Select Control Panel→Administrative

Tools→Computer Management→Disk Management, and then verify that the disk manager has
initialized all disks.

2. Assign the driver letter in the migrated virtual machine guest using the appropriate disk administrator
or manager.

Mouse and keyboard do not work after migrating a Hyper-V virtual machine to a ProLiant server
Before performing a migration, uninstall Hyper-V Integration Tools on the source virtual machine. If you
cannot uninstall the tools, then select Automatic PSP installation on the destination server Migration
Wizard so that the PSP is installed automatically on the destination server after a migration.

Static IP address cannot be assigned on the destination server after migration
Assigning a static IP address on the destination server might result in an error similar to the following:
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The IP address xxx.xxx.xxx.xxx you have entered for this network adapter is
already assigned to another adapter.

This scenario can occur if the IP address is assigned to a network adapter on the source server. For more
information, see http://support.microsoft.com/kb/269155/en-us.

Virtual machine hosts Integrated Components do not install on the destination virtual machine
following SMP migration

To resolve this issue:
1. Power down the destination virtual machine.
2. Add a CD-ROM drive to the virtual machine.
3. Power up the virtual machine, and then restart the installation of the Integrated Components.

Yellow bang (!) appears on the NIC adapter in Device Manager on the migrated virtual machine
After performing a migration, the NIC Adapter might not appear on the destination virtual machine. This
might happen during V2V migrations between VMware Server and VMWare ESX servers. This might also
appear when a virtual machine is migrated from one Hyper-V host to another Hyper-V host.
You might be unable to assign the IP address to this device, which does not reappear on the Network
Connections Page.
To resolve this issue, you must manually uninstall the Network adapter in the Device Manager and trigger
a Scan for Hardware Changes. This detects the NIC adapter and configures the drivers for it.

Uninstallation

Unable to uninstall an older version of the SMP application
This issue occurs if the related uninstallation file is missing. To resolve this issue:
1. Insert the SMP Boot CD in the CD drive of a different server.
2. Click Install Application, and then launch the application.
3. After the installation is complete, copy the unins000.exe and silentuninstall.exe files from

the SMP installation folder to the SMP installation folder on the server with the uninstallation issue.
4. To run the uninstallation process, double-click the unins000.exe file.

Uninstalling SMP using the uninstaller shortcut menu
1. Close all SMP Migration screens.
2. From the application station, click Start→Programs→HP Insight Server Migration software for

ProLiant→Uninstall HP Insight Server Migration software for ProLiant.
3. When prompted to confirm the uninstallation, click Yes.
The uninstallation runs in a minimized window, which closes upon completion. If any folders or files are
using the contents of SMP directory, the uninstallation does not remove those folders or files.
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9 HP support and contact information
HP Software Technical Support and Update Service

HP offers a number of software support services, many of which are provided to our customers at no additional
charge.

• Software Technical Support—HP Insight Server Migration software for ProLiant includes one year of
24 x 7 HP Software Technical Support Service. This service provides access to HP technical resources
for assistance in resolving software implementation or operations problems. With this service, Insight
Control and ProLiant Essentials customers will benefit from expedited problem resolution as well as
proactive notification and delivery of software updates. For more information about this service, see
http://www.hp.com/services/insight.
Registration for Software Technical Support:
There are two methods for registering:

• If you received a license entitlement certificate, automated registration for this service will take
place upon online redemption of the license certificate/key.

• If the license information you received for your product instructs you to register for Software
Technical Support and Update Service, follow the instructions so that you will be eligible for
telephone support and product updates.

How to Use Your Software Technical Support and Update Service:
Once registered, you will receive a service contract in the mail containing the Customer Service phone
number and your Service Agreement Identifier (SAID). You will need your SAID when calling for technical
support. Using your SAID, you can also go to the Software Update Manager (SUM) web page to view
your contract online and elect electronic delivery for product updates.

• Warranty—HP will replace defective delivery media for a period of 90 days from the date of purchase.
This warranty applies to all Insight Control Environment, HP Systems Insight Manager, and ProLiant
Essentials products.

• Join the discussion—The HP Support Forum is a community-based, user-supported tool for HP customers
to participate in discussions amongst the customer community about HP products. For discussions related
to Insight Control and ProLiant Essentials software, see the "Management Software and System Tools”
area.

• Software and Drivers download pages—These pages provide the latest software and drivers for your
ProLiant products.

• Management Security (http://www.hp.com/servers/manage/security)—HP is proactive in its approach
to the quality and security of all its management software. Be sure to check this website often for the
latest downloadable security updates.

• Obtain the latest SmartStart Release (http://www.hp.com/servers/smartstart)—The SmartStart,
Management, and Firmware CDs are now freely available for download following a simple registration
from the SmartStart website. If you wish to receive physical kits with each release, you can order single
release kits from the SmartStart website. To receive proactive notification when SmartStart releases are
available, subscribe to Subscriber's Choice at http://www.hp.com/go/subscriberschoice.

HP Worldwide Customer Service contact numbers are available at http://www.hp.com/country/us/en/
wwcontact.html. For U.S. customers, say “Insight Manager” when prompted for the product name.
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Support and information
For HP support and software updates for SMP, see the following resources:

• http://www.hp.com/go/insight

• HP Insight Server Migration software for ProLiant User Guide

• HP Insight Server Migration software for ProLiant Release Notes
For additional information about HP SIM, see the following resources:

• http://www.hp.com/go/hpsim

• HP SIM Technical Reference Guide

• HP Systems Insight Manager Help Guide

HP contact information
For the name of the nearest HP authorized reseller:

• In the United States, see the HP US service locator at http://www.hp.com/service_locator.

• In other locations, see Contact HP worldwide at http://welcome.hp.com/country/us/en/wwcontact.html.

For HP technical support:

• In the United States, for contact options see Contact HP United States at http://welcome.hp.com/
country/us/en/wwcontact.html. To contact HP by phone, call 1-800-HP-INVENT (1-800-474-6836).
This service is available 24 hours a day, 7 days a week. For continuous quality improvement, calls
may be recorded or monitored.

• In other locations, see Contact HP worldwide at http://welcome.hp.com/country/us/en/wwcontact.html.
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A Portable Images Network Tool (PINT)
The Portable Images Network Tool (PINT) automates NIC configuration on the destination servers during a
migration.
For more information on PINT, see the PINT readme files at system drive\Program Files\HP\HP
Insight Server Migration software for ProLiant\PINT.
PINT can only be use with specific servers. For more information, see the PINT readme files.
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Glossary
CMS HP SIM Central Management Server.
guest operating
system

A reference to a distinct operating system instance running in a virtual machine.

host operating
system

A reference to the operating system that is the foundation for a virtual machine.

HP ProLiant
Essentials Rapid
Deployment Pack

A multiserver deployment tool that enables IT administrators to easily configure and deploy large
volumes of servers in an unattended, automated fashion.

HP ProLiant
Support Pack (PSP)

An operating system-specific bundle of ProLiant optimized drivers, utilities, and management
agents. Each PSP includes setup and software maintenance tools designed to provide an efficient
way to install, upgrade, and manage system software.

HP SIM HP Systems Insight Manager.
hypervisor In virtualization technology, hypervisor is a software program that manages multiple operating

systems (or multiple instances of the same operating system) on a single computer system. The
hypervisor manages the system's processor, memory, and other resources to allocate what each
operating system requires.

Integrated Lights
Out (iLO)

An embedded server management technology that makes it possible to perform management
activities on an HP server from a remote location.

legacy operating
systems

An older operating system, often incompatible with current hardware. Virtual machines permit
legacy operating system to run on new hardware.

Microsoft Virtual
Server 2005

Microsoft host operating system that provides a virtual machine solution.

physical-to-ProLiant migration (P2P)
Migration of a physical machine to an HP ProLiant server. This process enables you to migrate
older servers with your system settings to faster servers.

physical-to-virtual migration (P2V)
Migration of a physical machine to a virtual machine guest within a Microsoft Virtual Server 2005
or VMware virtual machine host.

SMP HP Insight Server Migration software for ProLiant.
total estimated
transport volume

The total volume, consisting of several disks plus configuration files.

virtual machine
(VM)

The emulation of a complete hardware system from processor to network card in a self contained,
isolated software environment, enabling the simultaneous operation of otherwise incompatible
systems.

virtual-to-ProLiant migration (V2P)
Migration of a virtual machine guest to a ProLiant machine.

virtual-to-virtual
migration (V2V)

Migration of a virtual machine guest between virtualization layers, including Microsoft Virtual
Server 2005 and VMware Server.

virtualization A method of grouping computing resources together that allows them to be accessed in ways
that provide benefits over the original configuration. Virtualized resources generally improve
computing power and data storage.

VMware Server VMware Windows or Linux-based host operating system that provides a virtual machine solution.
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